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1 Frequently used topics

Quick Find
● Make a single copy

● Use HP ePrint

● Use HP Web Services applications

● Control panel layout

● Control-panel Home screen

● Replace the print cartridges

● Improve print quality

● Use the HP Reconfiguration Utility to change the product connection

● Solve wireless network problems
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Everyday jobs (Windows)
● Manually print on both sides (Windows)

● Print multiple pages per sheet (Windows)

● Select the page orientation (Windows)

● Select the paper type (Windows)

● Create a booklet (Windows)

● Scale a document to fit page size (Windows)

● Print the first or last page on different paper (Windows)

● Make a single copy

● Copy a multiple-page original

● Use HP ePrint

● Use HP Web Services applications

● Load the input tray
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Everyday jobs (Mac OS X)
● Manually print on both sides (Mac OS X)

● Print multiple pages per sheet (Mac OS X)

● Select the page orientation (Mac OS X)

● Select the paper type (Mac OS X)

● Create a booklet (Mac OS X)

● Scale a document to fit page size (Mac OS X)

● Print a cover page (Mac OS X)

● Make a single copy

● Copy a multiple-page original

● Use HP ePrint

● Use HP Web Services applications

● Load the input tray

Manage and maintain
● Print product reports

● Control panel layout

● Control-panel Home screen

● Replace the print cartridges

● Replace the imaging drum

● Improve print quality

● Use the HP Reconfiguration Utility to change the product connection

Solve problems
● Clear jams

● Improve print quality

● Improve copy quality

● Print a cleaning page

● Solve wireless network problems

ENWW Everyday jobs (Mac OS X) 3



4 Chapter 1   Frequently used topics ENWW



2 Product introduction

● Product front view

● Product back view

● Serial number and model number location

● Control panel layout

● Control-panel Home screen

● Print product reports

ENWW 5



Product front view

1

4

3

2

5

6

7

8

1 Camera

2 Capture stage

3 Output bin extension

4 On/off button

5 Input tray

6 Front cover

7 Print-cartridge door

8 Color touch screen control panel

WARNING! This product includes a camera arm that is used to photograph documents. This camera
arm is not intended to be used as a handle or carrying device. To carry the product, use the handles
located on the bottom right and left sides of the product.
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Product back view

5

2

3

4

1

1 Slot for a cable-type security lock

2 Rear jam-access door

3 Hi-Speed USB 2.0 port

4 Network port

5 Power connection

WARNING! This product includes a camera arm that is used to photograph documents. This camera
arm is not intended to be used as a handle or carrying device. To carry the product, use the handles
located on the bottom right and left sides of the product.
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Serial number and model number location
The serial number and product model number label is inside the print-cartridge door.
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Control panel layout

1 Touch screen display

2 Help button and light: provides access to the control panel help system

3 Right arrow button and light: moves the cursor to the right or moves the display image to the next screen

NOTE: This button illuminates only when the current screen can use this feature.

4 Cancel button and light: clears settings, cancels the current job or exits the current screen

NOTE: This button illuminates only when the current screen can use this feature.

5 Wireless light: indicates the wireless network is enabled. The light blinks while the product is establishing a connection to the
wireless network.

6 Attention light: indicates a problem with the product

7 Ready light: indicates the product is ready

8 Back button and light: returns to the previous screen

NOTE: This button illuminates only when the current screen can use this feature.

9 Left arrow button and light: moves the cursor to the left

NOTE: This button illuminates only when the current screen can use this feature.

10 Home button and light: provides access to the Home screen

ENWW Control panel layout 9



Control-panel Home screen
The Home screen provides access to the product features, and it indicates the product status.

NOTE: Depending on the product configuration, the features on the Home screen can vary. The
layout might also be reversed for some languages.

9

1 2 3 4 5 6

8

7

10

1 Web Services  button: provides quick access to HP Web Services features, including HP ePrint

HP ePrint is a tool that prints documents by using any e-mail enabled device to send them to the product’s e-mail
address.

2 Setup  button: provides access to the main menus

3 Wireless  button: provides access to the Wireless menu and wireless status information

NOTE: When you are connected to a wireless network, this icon changes to a set of signal strength bars.

4 Network  button: provides access to network settings and information. From the network settings screen, you
can print the Network Summary page.

5 Information  button: provides product status information. From the status summary screen, you can print the
Configuration Report page.

6 Supplies  button: provides information about supplies status. From the supplies summary screen, you can print
the Supplies Status page.

7 Apps button: provides access to the Apps menu to print directly from Web applications that you have downloaded
from the HPePrintCenter Web site at www.hpeprintcenter.com

8 Scan button: provides access to the scan feature
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9 Product status

10 Copy button: provides access to the copy feature
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Print product reports
From the Reports menu, you can print several informative pages about the product.

1. From the Home screen, touch the Setup  button.

2. Touch the Reports button.

3. Touch the name of the report that you want to print.

Menu item Description

Demo Page Prints a page that demonstrates print quality

Menu Structure Prints a map of the control panel-menu layout. The active settings for each menu are
listed.

Configuration Report Prints a list of all the product settings. Includes network information when the
product is connected to a network.

Supplies Status Prints the status for each print cartridge, including the following information: 

● Estimated percentage of cartridge life remaining

● Approximate pages remaining

● Part numbers for HP print cartridges

● Number of pages printed

● Information about ordering new HP print cartridges and recycling used HP
print cartridges

Network Summary Prints a list of all product network settings

Usage Page Prints a page that lists PCL pages, PCL 6 pages, PS pages, pages that were jammed
or mispicked in the product, monochrome (black and white) or color pages; and
reports the page count

PCL Font List Prints a list of all the PCL fonts that are installed

PS Font List Prints a list of all the PostScript (PS) fonts that are installed

PCL6 Font List Prints a list of all the PCL6 fonts that are installed

Color Usage Log Prints a report that shows the user name, application name, and color usage
information on a job-by-job basis

Service Page Prints the service report

Diagnostics Page Prints the calibration and color diagnostics pages

Print Quality Page Prints a page that helps solve problems with print quality
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3 Paper tray

● Supported paper sizes

● Supported paper types

● Load the input tray

● Tray capacity and paper orientation
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Supported paper sizes
NOTE: To obtain best print results, select the appropriate paper size and type in the printer driver
before printing.

Size Dimensions

Letter 216 x 279 mm (8.5 x 11 in)

Legal 216 x 356 mm (8.5 x 14 in)

A4 210 x 297 mm (8.27 x 11.69 in)

Executive 184 x 267 mm (7.25 x 10.5 in)

8.5 x 13 216 x 330 mm (8.5 x 13 in)

4 x 6 101.6 x 152.4 mm (4 x 6 in)

10 x 15 cm 101.6 x 152.4 mm (4 x 6 in)

5 x 8 127 x 203 mm (5 x 8 in)

RA4 215 x 305 mm (8.46 x 12.01 in)

A5 148 x 210 mm (5.83 x 8.27 in)

A6 105 x 148 mm (4.13 x 5.83 in)

B5 (JIS) 182 x 257 mm (7.17 x 10.12 in)

16k 184 x 260 mm (7.24 x 10.23 in)

195 x 270 mm (7.68 x 10.62 in)

197 x 273 mm (7.75 x 10.75 in)

Custom Minimum: 76 x 127 mm (3 x 5 in)

Maximum: 216 x 356 mm (8.5 x 14.0 in)

NOTE: When defining custom sizes using the printer driver, always specify the short
edge of the page as the width and the long edge as the length.

Envelope #10 105 x 241 mm (4.13 x 9.49 in)

Envelope DL 110 x 220 mm (4.33 x 8.66 in)

Envelope C5 162 x 229 mm (6.93 x 9.84 in)

Envelope B5 176 x 250 mm (6.7 x 9.8 in)

Envelope Monarch 98 x 191 mm (3.9 x 7.5 in)

Japanese Postcard

Postcard (JIS)

100 x 148 mm (3.93 x 5.82 in)

Double Japan Postcard Rotated

Double Postcard (JIS)

148 x 200 mm (5.83 x 7.87 in)
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Supported paper types
For a complete list of specific HP-brand paper that this product supports, go to www.hp.com/support/
LJColorMFPM275nw.

CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications might
cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard
warranty or service agreements.

CAUTION: HP LaserJet products use fusers to bond dry toner particles to the paper in very precise
dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper could damage the
product.

● Everyday

◦ Plain

◦ Light

◦ Bond

◦ Recycled

● Presentation

◦ Matte paper

◦ Glossy paper

◦ Heavy paper

◦ Heavy glossy paper

● Brochure

◦ Matte paper

◦ Glossy paper

◦ Tri-fold paper

◦ Extra heavy paper

◦ Extra heavy glossy paper

● Photo/Cover

◦ Matte cover paper

◦ Matte photo paper
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◦ Photo glossy paper

◦ Glossy cards

● Other

◦ Color laser transparency

◦ Labels

◦ Letterhead

◦ Envelope

◦ Heavy envelope

◦ Preprinted

◦ Prepunched

◦ Colored

◦ Rough

◦ Heavy rough

◦ HP Tough paper
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Load the input tray

1. Load the paper in the input tray.  

2. Adjust the guides until they are snug against
the paper.
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Tray capacity and paper orientation

Paper type Specifications Capacity Orientation for loading
paper

Paper 60-220 g/m2 (16-59 lb) 150 sheets of 75 g/m2 (20 lb) ● Side to be printed facing up

● Short edge leading into the
product

● For prepunched paper, the
holes should be on the left

Envelopes 60-90 g/m2 (16-24 lb bond) Up to 10 envelopes ● Side to be printed facing up

● Right, short edge leading
into the product

Transparencies 0.12-0.13 mm (0.0047-.0.0051
in)

Up to 50 transparencies ● Side to be printed facing up

● Short edge leading into the
product

Postcards 135-176 g/m2 (36-47 lb bond) ● Side to be printed facing up

● Short edge leading into the
product

Glossy paper 130-220 g/m2 (35-59 lb bond) ● Side to be printed facing up

● Short edge leading into the
product
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4 Print

● Supported printer drivers (Windows)

● Change print-job settings (Windows)

● Change print-job settings (Mac OS X)

● Use a printing shortcut (Windows)

● Create a printing shortcut (Windows)

● Use a printing preset (Mac OS X)

● Create a printing preset (Mac OS X)

● Manually print on both sides (Windows)

● Manually print on both sides (Mac OS X)

● Print multiple pages per sheet (Windows)

● Print multiple pages per sheet (Mac OS X)

● Select the page orientation (Windows)

● Select the page orientation (Mac OS X)

● Select the paper type (Windows)

● Select the paper type (Mac OS X)

● Print the first or last page on different paper (Windows)

● Print a cover page (Mac OS X)

● Scale a document to fit page size (Windows)

● Scale a document to fit page size (Mac OS X)

● Create a booklet (Windows)

● Create a booklet (Mac OS X)

● Change color options (Windows)

● Change the color options (Mac OS X)
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● Use the HP EasyColor option

● Change the color theme for a print job (Windows)

● Manual color options

● Match colors

● Additional print tasks

● Use HP ePrint

● Use AirPrint

20 Chapter 4   Print ENWW



Supported printer drivers (Windows)
Printer drivers provide access to the product features and allow the computer to communicate with the
product (using a printer language). Check the installation notes and readme files on the product CD for
additional software and languages.

HP PCL 6 driver description

● Installs from the Add Printer wizard

● Provided as the default driver

● Recommended for printing in all supported Windows environments

● Provides the overall best speed, print quality, and product-feature support for most users

● Developed to align with the Windows Graphic Device Interface (GDI) for the best speed in
Windows environments

● Might not be fully compatible with third-party and custom software programs that are based on
PCL 5

HP UPD PS driver description

● Available for download from the Web at www.hp.com/support/LJColorMFPM275nw_software

● Recommended for printing with Adobe® software programs or with other highly graphics-intensive
software programs

● Provides support for printing from postscript emulation needs, or for postscript flash font support

HP UPD PCL 5 driver description

● Available for download from the Web at www.hp.com/support/LJColorMFPM275nw_software

● Compatible with previous PCL versions and older HP LaserJet products

● The best choice for printing from third-party or custom software programs

● Designed for use in corporate Windows environments to provide a single driver for use with
multiple printer models

● Preferred when printing to multiple printer models from a mobile Windows computer
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Change print-job settings (Windows)

Priority for changing print-job settings

Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed here override settings
changed anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed in the Print dialog box
have a lower priority and usually do not override changes made in the Page Setup dialog box.

● Printer Properties dialog box (printer driver): Click Properties in the Print dialog box
to open the printer driver. Settings changed in the Printer Properties dialog box usually do not
override settings anywhere else in the printing software. You can change most of the print settings
here.

● Default printer driver settings: The default printer driver settings determine the settings used
in all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties
dialog boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower
priority than changes made anywhere else.

Change the settings for all print jobs until the software program is
closed

1. From the software program, select the Print option.

2. Select the driver, and then click Properties or Preferences.

Change the default settings for all print jobs

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the
default Start menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the
Classic Start menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware
and Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Printing Preferences.
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Change the product configuration settings

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the
default Start menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the
Classic Start menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware
and Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Properties or Printer properties.

3. Click the Device Settings tab.
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Change print-job settings (Mac OS X)

Priority for changing print-job settings

Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

● Page Setup dialog box: Click Page Setup or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed here might override
settings changed anywhere else.

● Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the
program you are working in to open this dialog box. Settings changed in the Print dialog box
have a lower priority and do not override changes made in the Page Setup dialog box.

● Default printer driver settings: The default printer driver settings determine the settings used
in all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties
dialog boxes.

● Printer control panel settings: Settings changed at the printer control panel have a lower
priority than changes made anywhere else.

Change the settings for all print jobs until the software program is
closed

1. On the File menu, click the Print button.

2. Change the settings that you want on the various menus.

Change the default settings for all print jobs

1. On the File menu, click the Print button.

2. Change the settings that you want on the various menus.

3. On the Presets menu, click the Save As... option and type a name for the preset.

These settings are saved in the Presets menu. To use the new settings, you must select the saved preset
option every time you open a program and print.

Change the product configuration settings

1. From the Apple menu , click the System Preferences menu and then click the Print & Fax
icon.

2. Select the product in the left side of the window.

3. Click the Options & Supplies button.
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4. Click the Driver tab.

5. Configure the installed options.
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Use a printing shortcut (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Printing Shortcuts tab.  

4. Select one of the shortcuts, and then click the
OK button.

NOTE: When you select a shortcut, the
corresponding settings change on the other
tabs in the printer driver.
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Create a printing shortcut (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Printing Shortcuts tab.  
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4. Select an existing shortcut as a base.

NOTE: Always select a shortcut before
adjusting any of the settings on the right side
of the screen. If you adjust the settings and
then select a shortcut, or if you select a
different shortcut, all your adjustments are lost.

 

5. Select the print options for the new shortcut.

NOTE: You can select the print options on
this tab or on any other tab in the printer
driver. After selecting options on other tabs,
return to the Printing Shortcuts tab before
continuing with the next step.
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6. Click the Save As button.  

7. Type a name for the shortcut, and click the OK
button.
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Use a printing preset (Mac OS X)
1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. In the Presets menu, select the printing preset.

NOTE: To use printer-driver default settings, select the Standard option.
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Create a printing preset (Mac OS X)
Use printing presets to save the current printer driver settings for reuse.

1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. Select the print settings that you want to save for reuse.

4. In the Presets menu, click the Save As... option, and type a name for the preset.

5. Click the OK button.
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Manually print on both sides (Windows)

1. From the software program, select the Print
option.

 

2. On the File menu in the software program,
click Print.

 

3. Select the product, and then click the
Properties or Preferences button.

 

4. Click the Finishing tab.  
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5. Select the Print on Both Sides (Manually)
check box. Click the OK button to print the
first side of the job.

 

6. Retrieve the printed stack from the output bin,
and, maintaining the paper orientation, place
it with the printed-side facing down in the input
tray.

 

7. On the product control panel, touch the OK
button.
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Manually print on both sides (Mac OS X)
1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. Open the Manual Duplex menu.

4. Click the Manual Duplex box, and select a binding option.

5. Click the Print button.

6. Go to the product, and remove any blank paper that is in Tray 1.

7. Retrieve the printed stack from the output bin, rotate the stack 180 degrees, and then place it with
the printed-side facing down in the input tray.

8. If prompted, touch the appropriate control panel button to continue.
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Print multiple pages per sheet (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  
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4. Select the number of pages per sheet from the
Pages Per Sheet drop-down list.

 

5. Select the correct Print Page Borders,
Page Order, and Orientation options.
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Print multiple pages per sheet (Mac OS X)
1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. Open the Layout menu.

4. From the Pages per Sheet menu, select the number of pages that you want to print on each
sheet (1, 2, 4, 6, 9, or 16).

5. In the Layout Direction area, select the order and placement of the pages on the sheet.

6. From the Borders menu, select the type of border to print around each page on the sheet.
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Select the page orientation (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  

4. In the Orientation area, select the Portrait
or Landscape option.

To print the page image upside down, select
the Rotated option.
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Select the page orientation (Mac OS X)
1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. In the Copies & Pages menu, click the Page Setup button.

4. Click the icon that represents the page orientation that you want to use, and then click the OK
button.
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Select the paper type (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  

4. From the Type is drop-down list, click the
More... option.
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5. Select the category of paper types that best
describes your paper.

 

6. Select the option for the type of paper you are
using, and click the OK button.
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Select the paper type (Mac OS X)
1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. Open the Finishing menu.

4. Select a type from the Media-type drop-down list.

5. Click the Print button.
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Print the first or last page on different paper
(Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Paper/Quality tab.  

4. Click the Use different paper check box,
and then select the necessary settings for the
front cover, other pages, and back cover.
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Print a cover page (Mac OS X)
1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. Open the Cover Page menu, and then select where to print the cover page. Click either the
Before Document button or the After Document button.

4. In the Cover Page Type menu, select the message that you want to print on the cover page.

NOTE: To print a blank cover page, select the Standard option from the Cover Page Type
menu.
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Scale a document to fit page size (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Effects tab.  

4. Select the Print Document On option, and
then select a size from the drop-down list.
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Scale a document to fit page size (Mac OS X)
1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. Open the Paper Handling menu.

4. In the Destination Paper Size area, click the Scale to fit paper size box, and then select
the size from the drop-down list.
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Create a booklet (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  
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4. Click the Print on Both Sides (Manually)
check box.

 

5. In the Booklet Printing drop-down list,
select a binding option. The Pages Per
Sheet option automatically changes to 2
Pages Per Sheet.
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Create a booklet (Mac OS X)
1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. Open the Manual Duplex menu.

4. Click the Manual Duplex box.

5. Open the Booklet Printing menu.

6. Click the Format Output As Booklet box, and select a binding option.

7. Select the paper size.
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Change color options (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Color tab.  

4. Click the Automatic or Manual setting.

● Automatic setting: Select this setting for
most color print jobs.

● Manual setting: Select this setting to
adjust the color settings independent from
other settings.

NOTE: Changing color settings
manually can impact output. HP
recommends that only color graphics
experts change these settings.

 

5. Click the Print in Grayscale option to print
a color document in black and shades of gray.
Use this option to print color documents for
photocopying or faxing. You can also use this
option to print draft copies or to save color
toner.

 

6. Click the OK button.  
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Change the color options (Mac OS X)
1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. Open the Color/Quality Options menu.

4. Open the Advanced menu.

5. Adjust the individual settings for text, graphics, and photographs.
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Use the HP EasyColor option
If you are using the HP PCL 6 printer driver for Windows, the HP EasyColor technology automatically
improves mixed-content documents that are printed from Microsoft Office programs. This technology
scans documents and automatically adjusts photographic images in .JPEG or .PNG format.
HP EasyColor technology enhances the entire image at one time, rather than dividing it into several
pieces, which results in improved color consistency, sharper details, and faster printing.

If you are using the HP Postscript printer driver for Mac, HP EasyColor technology scans all
documents and automatically adjusts all photographic images with the same improved photographic
results.

In the following example, the images on the left were created without using the HP EasyColor option.
The images on the right show the enhancements that result from using the HP EasyColor option.

The HP EasyColor option is enabled by default in both the HP PCL 6 printer driver and the HP Mac
Postscript printer driver, so you do not need to make manual color adjustments. To disable the option so
you can manually adjust the color settings, open the Color tab in the Windows driver or the Color/
Quality Options tab in the Mac driver, and then click the HP EasyColor check box to clear it.
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Change the color theme for a print job (Windows)

1. From the software program, select the Print
option.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Color tab.  

4. Select a color theme from the Color Themes
drop-down list.

● Default (sRGB): This theme sets the
product to print RGB data in raw device
mode. When using this theme, manage
color in the software program or in the
operating system for correct rendering.

● Vivid: The product increases the color
saturation in the midtones. Use this theme
when printing business graphics.

● Photo: The product interprets RGB color
as if it were printed as a photograph using
a digital mini lab. The product renders
deeper, more saturated colors differently
than with the Default (sRBG) theme. Use
this theme when printing photos.

● Photo (Adobe RGB 1998): Use this
theme with printing digital photos that use
the AdobeRGB color space rather than
sRGB. Turn off color management in the
software program when using this theme.

● None: No color theme is used.
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Manual color options
Use manual color options to adjust the Neutral Grays, Halftone, and Edge Control options for
text, graphics, and photographs.

Table 4-1  Manual color options

Setting description Setting options

Edge Control

The Edge Control setting determines the rendering
of edges. Edge control has two components:
adaptive halftoning and trapping. Adaptive
halftoning increases edge sharpness. Trapping
reduces the effect of color-plane misregistration by
overlapping the edges of adjacent objects slightly.

● Off turns off both trapping and adaptive halftoning.

● Light sets trapping at a minimal level. Adaptive halftoning is on.

● Normal sets trapping at a medium level. Adaptive halftoning is
on.

● Maximum is the most aggressive trapping setting. Adaptive
halftoning is on.

Halftone

Halftone options affect color output clarity and
resolution.

● Smooth provides better results for large, solid-filled print areas
and enhances photographs by smoothing color gradations. Select
this option when uniform and smooth area fills are important.

● Detail is useful for text and graphics that require sharp
distinctions among lines or colors, or images that contain a
pattern or a high level of detail. Select this option when sharp
edges and small details are important.

Neutral Grays

The Neutral Grays setting determines the method
for creating gray colors used in text, graphics, and
photographs.

● Black Only generates neutral colors (grays and black) by using
only black toner. This guarantees neutral colors without a color
cast. This setting is best for documents and grayscale viewgraphs.

● 4-Color generates neutral colors (grays and black) by combining
all four toner colors. This method produces smoother gradients
and transitions to other colors, and it produces the darkest black.
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Match colors
For most users, the best method for matching colors is to print sRGB colors.

The process of matching printer output color to your computer screen is complex, because printers and
computer monitors use different methods of producing color. Monitors display colors by using light
pixels that use an RGB (red, green, blue) color process, but printers print colors by using a CMYK
(cyan, magenta, yellow, and black) process.

Several factors can influence your ability to match printed colors to those on your monitor:

● Print media

● Printer colorants (inks or toners, for example)

● Printing process (inkjet, press, or laser technology, for example)

● Overhead lighting

● Personal differences in perception of color

● Software programs

● Printer drivers

● Computer operating systems

● Monitors

● Video cards and drivers

● Operating environment (humidity, for example)

Keep these factors in mind when colors on your screen do not perfectly match your printed colors.
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Additional print tasks

Cancel a print job (Windows)

1. If the print job is currently printing, cancel it by pressing the Cancel  button on the product
control panel.

NOTE: Pressing the Cancel  button clears the job that the product is currently processing. If
more than one process is running, pressing the Cancel  button clears the process that currently
appears on the product control panel.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen,
allowing you to cancel the print job.

● Windows print queue: If a print job is waiting in a print queue (computer memory) or
print spooler, delete the job there.

◦ Windows XP, Server 2003, or Server 2008: Click Start, click Settings, and
then click Printers and Faxes. Double-click the product icon to open the window,
right-click the print job that you want to cancel, and then click Cancel.

◦ Windows Vista: Click Start, click Control Panel, and then, under Hardware
and Sound, click Printer. Double-click the product icon to open the window, right-
click the print job that you want to cancel, and then click Cancel.

◦ Windows 7: Click Start, and then click Devices and Printers. Double-click the
product icon to open the window, right-click the print job that you want to cancel, and
then click Cancel.

Cancel a print job (Mac OS X)

1. If the print job is currently printing, cancel it by pressing the Cancel  button on the product
control panel.

NOTE: Pressing the Cancel  button clears the job that the product is currently processing. If
more than one print job is waiting, pressing the Cancel  button clears the print job that currently
appears on the product control panel.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen,
allowing you to cancel the print job.

● Mac print queue: Open the print queue by double-clicking the product icon in the dock.
Highlight the print job, and then click Delete.
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Select the paper size (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Size is drop-down list.

Select the paper size (Mac OS X)

1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. In the Copies & Pages menu, click the Page Setup button.

4. Select a size from the Paper Size drop-down list, and then click the OK button.

Select a custom paper size (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the Custom button.

5. Type a name for the custom size and specify the dimensions.

● The width is the short edge of the paper.

● The length is the long edge of the paper.

NOTE: Always load paper into the trays short edge first.

6. Click the Save button, and then click the Close button.

Select a custom paper size (Mac OS X)

1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. In the Copies & Pages menu, click the Page Setup button.

4. From the Paper Size drop-down list, select the Manage Custom Sizes option.

5. Specify the dimensions for the page size, and then click the OK button.
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Print colored text as black (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the Print all Text as Black check box. Click the OK button.

Print watermarks (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Effects tab.

4. Select a watermark from the Watermarks drop-down list.

Or, to add a new watermark to the list, click the Edit button. Specify the settings for the
watermark, and then click the OK button.

5. To print the watermark on the first page only, select the First Page Only check box. Otherwise,
the watermark is printed on each page.

Print watermarks (Mac OS X)

1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. Open the Watermarks menu.

4. From the Mode menu, select the type of watermark to use. Select the Watermark option to print
a semi-transparent message. Select the Overlay option to print a message that is not transparent.

5. From the Pages menu, select whether to print the watermark on all pages or on the first page
only.

6. From the Text menu, select one of the standard messages, or select the Custom option and type
a new message in the box.

7. Select options for the remaining settings.

Create archival-quality prints

Archive print produces output that is less susceptible to toner smearing and dusting. Use archive print to
create documents that you want to preserve or archive.

1. From the Home screen, touch the Setup  button.

2. Touch the Service menu.

3. Touch the Archive Print button, and then touch the On button.
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Use HP ePrint
Use HP ePrint to print documents by sending them as an e-mail attachment to the product's e-mail
address from any e-mail enabled device.

NOTE: The product must be connected to a wired or wireless network and have Internet access to use
HP ePrint.

1. To use HP ePrint, you must first enable HP Web Services.

a. From the Home screen on the product control panel, touch the Web Services  button.

b. Touch the Enable Web Services button.

2. From the HP Web Services menu, touch the Display E-Mail Address button to display the product's
e-mail address on the control panel.

3. Use the HP ePrintCenter Web site to define security settings and to configure default print settings
for all HP ePrint jobs sent to this product.

a. Go to www.hpeprintcenter.com.

b. Click Sign In, and enter your HP ePrintCenter credentials or sign up for a new account.

c. Select your product from the list, or click + Add printer to add it. To add the product, you
need the printer code, which is the segment of the product e-mail address that is before the @
symbol.

NOTE: This code is valid for only 24 hours from the time you enable HP Web Services. If it
expires, follow the instructions to enable HP Web Services again, and obtain a new code.

d. To prevent your product from printing unexpected documents, click ePrint Settings, and
then click the Allowed Senders tab. Click Allowed Senders Only, and add the e-mail
addresses from which you want to allow ePrint jobs.

e. To set up default settings for all ePrint jobs sent to this product, click ePrint Settings, click
Print Options, and select the settings that you want to use.

4. To print a document, attach it to an e-mail message sent to the product's e-mail address.
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Use AirPrint
Direct printing using Apple’s AirPrint is supported for iOS 4.2 or later. Use AirPrint to print directly to
the product from an iPad (iOS 4.2), iPhone (3GS or later), or iPod touch (third generation or later) in
the following applications:

● Mail

● Photos

● Safari

● Select third-party applications

To use AirPrint, the product must be connected to a network. For more information about using AirPrint
and about which HP products are compatible with AirPrint, go to www.hp.com/go/airprint.

NOTE: You might need to upgrade the product firmware to use AirPrint. Go to www.hp.com/
support/LJColorMFPM275nw.
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5 Copy

● Make a single copy

● Make multiple copies

● Copy a multiple-page original

● Collate a copy job

● Copy on both sides (duplex)

● Reduce or enlarge a copy

● Make color or black and white copies

● Copy identification cards

● Optimize copy quality

● Adjust the lightness or darkness for copies

● Adjust the copy image

● Copy in draft mode

● Set the paper size and type for copying on special paper

● Set new default copy settings

● Restore copy default settings
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Make a single copy

1. Raise the camera arm to the fully open
position.

 

2. Place the document or object on the capture
stage, facing up. Align the top left corner of
documents with the ridges along the right and
rear edges of the capture stage.

 

3. From the Home screen, touch the Copy button.  
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4. Touch the arrows to scroll through and select
one of the Capture options.

● Auto: The product automatically detects
whether the item on the capture stage is a
document or an object.

● Document: The product uses capture
settings optimized for documents.

● 3D Object: The product uses capture
settings optimized for three-dimensional
objects.

 

5. Touch the Black or Color button to start
copying.

 

6. When you are finished, lower the camera arm.

NOTE: Lower the camera arm to protect the
camera lens cover from damage.
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Make multiple copies

1. Raise the camera arm to the fully open
position.

 

2. Place the document or object on the capture
stage, facing up. Align the top left corner of
documents with the ridges along the right and
rear edges of the capture stage.

 

3. From the Home screen, touch the Copy button.  
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4. Touch the arrows to scroll through and select
one of the Capture options.

● Auto: The product automatically detects
whether the item on the capture stage is a
document or an object.

● Document: The product uses capture
settings optimized for documents.

● 3D Object: The product uses capture
settings optimized for three-dimensional
objects.

 

5. Touch the arrows to change the number of
copies, or touch the existing number and type
the number of copies.
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6. Touch the Black or Color button to start
copying.

 

7. When you are finished, lower the camera arm.

NOTE: Lower the camera arm to protect the
camera lens cover from damage.
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Copy a multiple-page original

1. Raise the camera arm to the fully open
position.

 

2. Place the document or object on the capture
stage, facing up. Align the top left corner of
documents with the ridges along the right and
rear edges of the capture stage.

 

3. From the Home screen, touch the Copy button.  
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4. Touch the arrows to scroll through and select
one of the Capture options.

● Auto: The product automatically detects
whether the item on the capture stage is a
document or an object.

● Document: The product uses capture
settings optimized for documents.

● 3D Object: The product uses capture
settings optimized for three-dimensional
objects.

 

5. Touch the Settings button.  

6. Scroll to and touch the Multi-Page Copy
button.
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7. Touch the On button.  

8. Touch the Black or Color button to start
copying.
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9. The product prompts you to load the next
page. When you are ready, touch the OK
button.

Repeat this step until you have copied all the
pages. When you are finished, touch the Done
button.

 

10. When you are finished, lower the camera arm.

NOTE: Lower the camera arm to protect the
camera lens cover from damage.

 

NOTE: Using this feature can save time when copying multi-page documents. However, when this
feature is enabled, the product prompts you to load the next page even when you have only one page
to copy. If you frequently copy only one page and you wish to avoid the prompt, turn this feature off.
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Collate a copy job
Use the Collation feature in conjunction with the Multi-Page Copy feature to easily collate multi-page
copies into sets of documents.

1. Raise the camera arm to the fully open
position.

 

2. Place the document or object on the capture
stage, facing up. Align the top left corner of
documents with the ridges along the right and
rear edges of the capture stage.

 

3. From the Home screen, touch the Copy button.  
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4. Touch the arrows to scroll through and select
one of the Capture options.

● Auto: The product automatically detects
whether the item on the capture stage is a
document or an object.

● Document: The product uses capture
settings optimized for documents.

● 3D Object: The product uses capture
settings optimized for three-dimensional
objects.

 

5. Touch the arrows to change the number of
copies, or touch the existing number and type
the number of copies.

 

6. Touch the Settings button.  
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7. Scroll to and touch the Multi-Page Copy
button.

 

8. Touch the On button.  

9. Touch the Collation button.  
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10. Touch the arrow buttons to scroll through the
options.

 

11. Touch the On button.  

12. Touch the Black or Color button to start
copying.

 

76 Chapter 5   Copy ENWW



13. The product prompts you to load the next
page. When you are ready, touch the OK
button.

Repeat this step until you have copied all the
pages. When you are finished, touch the Done
button. The product holds the pages in memory
until you have finished, and then it prints the
sets of copies.

 

14. When you are finished, lower the camera arm.

NOTE: Lower the camera arm to protect the
camera lens cover from damage.
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Copy on both sides (duplex)

1. Raise the camera arm to the fully open
position.

 

2. Place the document or object on the capture
stage, facing up. Align the top left corner of
documents with the ridges along the right and
rear edges of the capture stage.

 

3. From the Home screen, touch the Copy button.  
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4. Touch the arrows to scroll through and select
one of the Capture options.

● Auto: The product automatically detects
whether the item on the capture stage is a
document or an object.

● Document: The product uses capture
settings optimized for documents.

● 3D Object: The product uses capture
settings optimized for three-dimensional
objects.

 

5. Touch the Black or Color button to start
copying.

 

6. Remove the printed copy from the output bin,
rotate the stack 180 degrees, and then load
the page with the printed side down into
Tray 1.
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7. Place the next page of the document onto the
capture stage.

 

8. From the Home screen, touch the Copy button.  

9. Touch the Black or Color button to start
copying.
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10. Repeat these steps until the copy is complete.  

11. When you are finished, lower the camera arm.

NOTE: Lower the camera arm to protect the
camera lens cover from damage.
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Reduce or enlarge a copy

1. Raise the camera arm to the fully open
position.

 

2. Place the document or object on the capture
stage, facing up. Align the top left corner of
documents with the ridges along the right and
rear edges of the capture stage.

 

3. From the Home screen, touch the Copy button.  
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4. Touch the arrows to scroll through and select
one of the Capture options.

● Auto: The product automatically detects
whether the item on the capture stage is a
document or an object.

● Document: The product uses capture
settings optimized for documents.

● 3D Object: The product uses capture
settings optimized for three-dimensional
objects.

 

5. Touch the Settings button.  

6. Touch the Reduce/Enlarge button.  
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7. Touch the arrow buttons to scroll through the
options, and then touch an option to select it.

 

8. Touch the Black or Color button to start
copying.

 

9. When you are finished, lower the camera arm.

NOTE: Lower the camera arm to protect the
camera lens cover from damage.
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Make color or black and white copies

1. Raise the camera arm to the fully open
position.

 

2. Place the document or object on the capture
stage, facing up. Align the top left corner of
documents with the ridges along the right and
rear edges of the capture stage.

 

3. From the Home screen, touch the Copy button.  
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4. Touch the arrows to scroll through and select
one of the Capture options.

● Auto: The product automatically detects
whether the item on the capture stage is a
document or an object.

● Document: The product uses capture
settings optimized for documents.

● 3D Object: The product uses capture
settings optimized for three-dimensional
objects.

 

5. Touch the Black or Color button to start
copying.

 

6. When you are finished, lower the camera arm.

NOTE: Lower the camera arm to protect the
camera lens cover from damage.
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Copy identification cards
Use the ID Copy feature to copy both sides of identification cards, or other small-size documents, onto
the same side of one sheet of paper. The product prompts you to copy the first side and then to place
the second side on a different area of the capture stage and copy again. The product prints both
images at the same time.

1. Raise the camera arm to the fully open
position.

 

2. Place the document on the capture stage,
facing up.
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3. From the Home screen, touch the Copy button.  

4. Touch the arrows to scroll through and select
one of the Capture options.

● Auto: The product automatically detects
whether the item on the capture stage is a
document or an object.

● Document: The product uses capture
settings optimized for documents.

● 3D Object: The product uses capture
settings optimized for three-dimensional
objects.

 

5. Touch the ID Copy button. The button
illuminates while you complete the copy job.

 

6. Touch the Black or Color button to start
copying.
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7. The product prompts you to place the next
page on a different section of the capture
stage. When you are ready, touch the OK
button.

 

8. Touch the OK button if you have more pages
to copy, or touch the Done button if this is the
last page.

 

9. The product copies all pages onto one side of
a sheet of paper.

 

10. When you are finished, lower the camera arm.

NOTE: Lower the camera arm to protect the
camera lens cover from damage.
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Optimize copy quality

1. Raise the camera arm to the fully open
position.

 

2. Place the document or object on the capture
stage, facing up. Align the top left corner of
documents with the ridges along the right and
rear edges of the capture stage.

 

3. From the Home screen, touch the Copy button.  
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4. Touch the arrows to scroll through and select
one of the Capture options.

● Auto: The product automatically detects
whether the item on the capture stage is a
document or an object.

● Document: The product uses capture
settings optimized for documents.

● 3D Object: The product uses capture
settings optimized for three-dimensional
objects.

 

5. Touch the Settings button.  

6. Scroll to and touch the Optimize button.  
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7. Touch the arrow buttons to scroll through the
options, and then touch an option to select it.

● Auto Select: Use this setting to
automatically select the best mode for the
highest quality. This is the default setting.

● Mixed: Use this setting for documents that
contain a mixture of text and graphics.

● Text: Use this setting for documents that
contain mostly text.

● Picture: Use this setting for documents that
contain mostly graphics.

 

8. Touch the Black or Color button to start
copying.

 

9. When you are finished, lower the camera arm.

NOTE: Lower the camera arm to protect the
camera lens cover from damage.
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Adjust the lightness or darkness for copies

1. Raise the camera arm to the fully open
position.

 

2. Place the document or object on the capture
stage, facing up. Align the top left corner of
documents with the ridges along the right and
rear edges of the capture stage.

 

3. From the Home screen, touch the Copy button.  
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4. Touch the arrows to scroll through and select
one of the Capture options.

● Auto: The product automatically detects
whether the item on the capture stage is a
document or an object.

● Document: The product uses capture
settings optimized for documents.

● 3D Object: The product uses capture
settings optimized for three-dimensional
objects.

 

5. Touch the Settings button.  

6. Touch the Lighter/Darker button.  

94 Chapter 5   Copy ENWW



7. Touch the — or + buttons to adjust the
lightness/darkness setting, and then touch the
OK button.

 

8. Touch the Black or Color button to start
copying.

 

9. When you are finished, lower the camera arm.

NOTE: Lower the camera arm to protect the
camera lens cover from damage.
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Adjust the copy image

1. Raise the camera arm to the fully open
position.

 

2. Place the document or object on the capture
stage, facing up. Align the top left corner of
documents with the ridges along the right and
rear edges of the capture stage.

 

3. From the Home screen, touch the Copy button.  
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4. Touch the arrows to scroll through and select
one of the Capture options.

● Auto: The product automatically detects
whether the item on the capture stage is a
document or an object.

● Document: The product uses capture
settings optimized for documents.

● 3D Object: The product uses capture
settings optimized for three-dimensional
objects.

 

5. Touch the Settings button.  

6. Scroll to and touch the Image Adjustment
button.
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7. Touch the name of the setting you want to
adjust.

● Lightness: Adjusts the lightness/darkness
setting.

● Contrast: Adjusts the contrast between the
lightest and darkest areas of the image.

● Sharpen: Adjusts clarity of text characters.

● Background Removal: Adjusts the darkness
of the background of the image. This is
especially useful for original documents
that are printed on colored paper.

● Color Balance: Adjusts the red, green, and
blue color hues.

● Grayness: Adjusts the vividness of colors.

 

8. Touch the — or + buttons to adjust the value
for the setting, and then touch the OK button.

 

9. Adjust another setting, or touch the back arrow
to return to the main copy menu.
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10. Touch the Black or Color button to start
copying.

 

11. When you are finished, lower the camera arm.

NOTE: Lower the camera arm to protect the
camera lens cover from damage.
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Copy in draft mode
Using draft mode can use less toner and decrease the cost per page. However, using draft mode can
also reduce print quality.

HP does not recommend the full-time use of draft mode. If draft mode is used full-time, the toner supply
might outlast the mechanical parts in the print cartridge. If print quality begins to degrade and is no
longer acceptable, consider replacing the print cartridge.

1. Raise the camera arm to the fully open
position.

 

2. Place the document or object on the capture
stage, facing up. Align the top left corner of
documents with the ridges along the right and
rear edges of the capture stage.
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3. From the Home screen, touch the Copy button.  

4. Touch the arrows to scroll through and select
one of the Capture options.

● Auto: The product automatically detects
whether the item on the capture stage is a
document or an object.

● Document: The product uses capture
settings optimized for documents.

● 3D Object: The product uses capture
settings optimized for three-dimensional
objects.

 

5. Touch the Settings button.  
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6. Scroll to and touch the Draft Mode button.  

7. Touch the On button.  
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8. Touch the Black or Color button to start
copying.

 

9. When you are finished, lower the camera arm.

NOTE: Lower the camera arm to protect the
camera lens cover from damage.
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Set the paper size and type for copying on special
paper

1. Raise the camera arm to the fully open
position.

 

2. Place the document or object on the capture
stage, facing up. Align the top left corner of
documents with the ridges along the right and
rear edges of the capture stage.

 

3. From the Home screen, touch the Copy button.  
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4. Touch the arrows to scroll through and select
one of the Capture options.

● Auto: The product automatically detects
whether the item on the capture stage is a
document or an object.

● Document: The product uses capture
settings optimized for documents.

● 3D Object: The product uses capture
settings optimized for three-dimensional
objects.

 

5. Touch the Settings button.  

6. Scroll to and touch the Paper button.  
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7. From the list of paper sizes, touch the name of
the paper size that is in the tray.

 

8. From the list of paper types, touch the name of
the paper type that is in the tray.
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9. Touch the Black or Color button to start
copying.

 

10. When you are finished, lower the camera arm.

NOTE: Lower the camera arm to protect the
camera lens cover from damage.
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Set new default copy settings
You can save any combination of copy settings as the default settings to use for every job.

1. From the Home screen, touch the Copy button.  

2. Touch the Settings button.  
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3. Configure the copy settings to meet your
preferences, and then scroll to and touch the
Set as New Defaults button.

 

4. Touch the Yes button.  
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Restore copy default settings
Use this procedure to restore the factory default copy settings.

1. From the Home screen, touch the Copy button.  

2. Touch the Settings button.  
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3. Scroll to and touch the Restore Defaults button.  

4. Touch the OK button to restore the defaults.  
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6 Scan

● Scan by using the HP Scan software (Windows)

● Scan by using the HP Scan software (Mac OS X)

● Scan by using other software

● Set up scan to network folder and scan to email features

● Scan to a network folder

● Scan to email
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Scan by using the HP Scan software (Windows)
1. Double-click the HP Scan icon on the computer desktop.

2. Select a scanning shortcut, and adjust the settings if necessary.

3. Click Scan.

NOTE: Click Advanced Settings to gain access to more options.

Click Create New Shortcut to create a customized set of settings and save it in the list of shortcuts.

For more information about scan features, go to www.hp.com/support/LJColorMFPM275nw.
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Scan by using the HP Scan software (Mac OS X)
1. Open the Applications folder, and then click Hewlett-Packard. Double-click HP Scan.

2. Open the HP Scan menu and click Preferences. From the Scanner pop-up menu, select this
product from the list, and click Continue.

3. To use the standard preset settings, which produce acceptable results for images and text, click the
Scan button.

To use presets optimized for pictures or text documents, select a preset from the Scanning
Presets pop-up menu. To adjust the settings, click the Edit button. When you are ready to scan,
click the Scan button.

4. To scan more pages, load the next page and click Scan. Click Append to List to add the new
pages to the current list. Repeat until you have scanned all the pages.

5. Click the Save button, and then browse to the folder on your computer where you want to save
the file.

NOTE: To print the scanned images now, click the Print button.
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Scan by using other software
The product is TWAIN-compliant and Windows Imaging Application (WIA)-compliant. The product
works with Windows-based programs that support TWAIN-compliant or WIA-compliant scanning
devices and with Macintosh-based programs that support TWAIN-compliant scanning devices.

While you are in a TWAIN-compliant or WIA-compliant program, you can gain access to the scanning
feature and scan an image directly into the open program. For more information, see the Help file or
the documentation that came with your TWAIN-compliant or WIA-compliant software program.

Scan from a TWAIN-compliant program

Generally, a software program is TWAIN-compliant if it has a command such as Acquire, File
Acquire, Scan, Import New Object, Insert from, or Scanner. If you are unsure whether the
program is compliant or you do not know what the command is called, see the software program Help
or documentation.

When scanning from a TWAIN-compliant program, the HP Scan software program might start
automatically. If the HP Scan program starts, you can make changes while previewing the image. If the
program does not start automatically, the image goes to the TWAIN-compliant program immediately.

Start the scan from within the TWAIN-compliant program. See the software program Help or
documentation for information about the commands and steps to use.

Scan from a WIA-compliant program

WIA is another way to scan an image directly into a software program. WIA uses Microsoft software
to scan, instead of the HP Scan software.

Generally, a software program is WIA-compliant if it has a command such as Picture/From
Scanner or Camera in the Insert or File menu. If you are unsure whether the program is WIA-
compliant, see the software program Help or documentation.

Start the scan from within the WIA-compliant program. See the software program Help or
documentation for information about the commands and steps to use.

-Or-

From the Windows control panel, in the Cameras and Scanner folder (located inside the
Hardware and Sound folder for Windows Vista and Windows 7), double-click the product icon.
This opens the standard Microsoft WIA Wizard, which enables you to scan to a file.

Scan by using optical character recognition (OCR) software

The Readiris OCR program is included on a separate CD that shipped with the product. To use the
Readiris program, install it from the appropriate software CD, and then follow the instructions in the
online Help.
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Set up scan to network folder and scan to email
features

These scan features are not available until you use the HP Embedded Web Server to configure them.
The following instructions describe setting up the scan settings.

1. From the Home screen on the product control panel, touch the Network  button to find the
product IP address.

2. To open the HP Embedded Web Server, type the product IP address into the address line of a
Web browser.

NOTE: You can also access the HP Embedded Web Server from the HP Device Toolbox for
Windows or the HP Utility for Mac OS X.

3. Click the Scan tab to set up the feature.

ENWW Set up scan to network folder and scan to email features 117



Scan to a network folder
Use the product control panel to scan a file to a folder on the network.

NOTE: In order to use this feature, the product must be connected to a network and the scan feature
must be configured using the HP Embedded Web Server.

1. Raise the camera arm to the fully open
position.

 

2. Place the document or object on the capture
stage, facing up. Align the top left corner of
documents with the ridges along the right and
rear edges of the capture stage.

 

3. Touch the Scan to Network Folder item.  

4. In the list of network folders, select the folder to
which you want to save the file.

 

5. The control panel screen displays the scan
settings.

● If you want to change any of the settings,
touch the Settings button, and then change
the settings.

● If the settings are correct, go to the next
step.

 

6. Touch the Scan button to start the scan job.  
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Scan to email
Use the product control panel to scan a file directly to an email address. The scanned file is sent to the
address as an email message attachment.

NOTE: In order to use this feature, the product must be connected to a network and the scan feature
must be configured using the HP Embedded Web Server.

1. Raise the camera arm to the fully open
position.

 

2. Place the document or object on the capture
stage, facing up. Align the top left corner of
documents with the ridges along the right and
rear edges of the capture stage.

 

3. From the Home screen, touch the Scan button.  

4. Touch the Scan to E-mail item.  

5. Touch the Send to E-mail item.  

6. Select the From address that you want to use.
This is also known as an “outgoing email
profile.”

NOTE: If the PIN feature has been set up,
enter the PIN and touch the OK button.
However, a PIN is not required to use this
feature.
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7. Touch the To button and pick the address or
group to which you want to send the file.
Touch the Done button when finished.

 

8. Touch the Subject button if you would like to
add a subject line

 

9. Touch the Next button.  

10. The control panel screen displays the scan
settings.

● If you want to change any of the settings,
touch the Settings button, and then change
the settings.

● If the settings are correct, go to the next
step.

 

11. Touch the Scan button to start the scan job.  
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7 Manage and maintain

● Use the HP Reconfiguration Utility to change the product connection

● Use HP Web Services applications

● Configure IP network settings

● HP Device Toolbox (Windows)

● HP Utility for Mac OS X

● Product security features

● Economy settings

● Print when a print cartridge or imaging drum is at estimated end of life

● Replace the print cartridges

● Replace the imaging drum

● Update the firmware
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Use the HP Reconfiguration Utility to change the
product connection

If you are already using the product and you wish to change the way it is connected, use the
HP Reconfiguration Utility to set up the connection. For example, you can reconfigure the product to use
a different wireless address, to connect to a wired or wireless network, or change from a network
connection to a USB connection. You can change the configuration without inserting the product CD.
After you select the type of connection you wish to make, the program goes directly to the portion of
the product setup procedure that needs to change.

The HP Reconfiguration Utility is located in the HP programs group on your computer.
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Use HP Web Services applications
Several innovative applications are available for this product that you can download directly from the
Internet. For more information and to download these applications go to the HP ePrintCenter Web site
at www.hpeprintcenter.com.

To use this feature, the product must be connected to a computer or network that has an Internet
connection. HP Web Services must be enabled on the product. Follow this procedure to enable
HP Web Services:

1. From the Home screen on the product control panel, touch the Web Services  button.

2. Touch the Enable Web Services button.

After you download an application from the HP ePrintCenter Web site, it is available in the Apps menu
on the product control panel.

ENWW Use HP Web Services applications 123

http://www.hpeprintcenter.com


Configure IP network settings

Printer sharing disclaimer

HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems
and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.

View or change network settings

Use the HP Embedded Web Server to view or change IP configuration settings.

1. From the Home screen on the product control panel, touch the Network  button to find the
product IP address.

2. To open the HP Embedded Web Server, type the IP address into the address line of a Web
browser.

NOTE: You can also access the HP Embedded Web Server from the HP Device Toolbox for
Windows or the HP Utility for Mac OS X.

3. Click the Networking tab to obtain network information. You can change settings as needed.

Manually configure IPv4 TCP/IP parameters from the control panel

Use the control-panel menus to manually set an IPv4 address, subnet mask, and default gateway.

1. Touch the Setup  button.

2. Scroll to and touch the Network Setup menu.

3. Touch the TCP/IP Config menu, and then touch the Manual button.

4. Use the numeric keypad to enter the IP address, and touch the OK button. Touch the Yes button to
confirm.

5. Use the numeric keypad to enter the subnet mask, and touch the OK button. Touch the Yes button
to confirm.

6. Use the numeric keypad to enter the default gateway, and touch the OK button. Touch the Yes
button to confirm.
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Rename the product on a network

If you want to rename the product on a network so that it can be uniquely identified, use the
HP Embedded Web Server.

1. From the Home screen on the product control panel, touch the Network  button to find the
product IP address.

2. To open the HP Embedded Web Server, type the product IP address into the address line of a
Web browser.

NOTE: You can also access the HP Embedded Web Server from the HP Device Toolbox for
Windows or the HP Utility for Mac OS X.

3. Open the System tab.

4. On the Device Information page, the default product name is in the Device Description
field. You can change this name to uniquely identify this product.

NOTE: Completing the other fields on this page is optional.

5. Click the Apply button to save the changes.
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Link speed and duplex settings

NOTE: This information applies only to Ethernet networks. It does not apply to wireless networks.

The link speed and communication mode of the print server must match the network hub. For most
situations, leave the product in automatic mode. Incorrect changes to the link speed and duplex settings
might prevent the product from communicating with other network devices. If you need to make
changes, use the product control panel.

NOTE: The setting must match with the network product to which you are connecting (a network hub,
switch, gateway, router, or computer).

NOTE: Making changes to these settings causes the product to turn off and then on. Make changes
only when the product is idle.

1. Touch the Setup  button.

2. Scroll to and touch the Network Setup menu.

3. Touch the Link Speed menu.

4. Select one of the following options.

Setting Description

Automatic The print server automatically configures itself for the highest link speed and
communication mode allowed on the network.

10T Half 10 megabytes per second (Mbps), half-duplex operation

10T Full 10 Mbps, full-duplex operation

100TX Half 100 Mbps, half-duplex operation

100TX Full 100 Mbps, full-duplex operation

5. Touch the OK button. The product turns off and then on.
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HP Device Toolbox (Windows)
Use the HP Device Toolbox for Windows to view or change product settings from your computer. This
tool opens the HP Embedded Web Server for the product.

NOTE: This tool is available only if you performed a full installation when you installed the product.

1. Click the Start button, and then click the Programs item.

2. Click your HP product group, and then click the HP Device Toolbox item.

Tab or section Description

Status tab

Provides product, status, and
configuration information.

● Device Status: Shows the product status and shows the approximate percent life
remaining of HP supplies.

● Supplies Status: Shows the approximate percent life remaining of HP supplies.
Actual supply life remaining can vary. Consider having a replacement supply
available to install when print quality is no longer acceptable. The supply does not
need to be replaced unless the print quality is no longer acceptable.

● Device Configuration: Shows the information found on the product configuration
page.

● Network Summary: Shows the information found on the product network
configuration page.

● Reports: Allows you to print the configuration and supplies status pages that the
product generates.

● Color Usage Log: Shows a log that shows the user name, application name, and
color usage information on a job-by-job basis.

● Event Log: Shows a list of all product events and errors.

● Support button: Provides a link to the product support page.

● Shop for Supplies button: Provides a link to a page where you can order
supplies for the product.
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Tab or section Description

System tab

Provides the ability to configure the
product from your computer.

● Device Information: Provides basic product and company information.

● Paper Setup: Allows you to change the paper-handling defaults for the product.

● Print Quality: Allows you to change the print quality defaults for the product,
including calibration settings.

● Print Density: Allows you to change the contrasts, highlights, midtones, and
shadows values for each supply.

● Paper Types: Allows you to configure print modes that correspond to the paper
types that the product accepts.

● System Setup: Allows you to change the system defaults for the product.

● Service: Allows you to start the cleaning procedure on the product.

● Product Security: Allows you to set or change the product password.

● Support button: Provides a link to the product support page.

● Shop for Supplies button: Provides a link to a page where you can order
supplies for the product.

NOTE: The System tab can be password-protected. If this product is on a network,
always consult with the administrator before changing settings on this tab.

Print tab

Provides the ability to change
default print settings from your
computer.

● Printing: Change the default product print settings, such as number of copies and
paper orientation. These are the same options that are available on the control
panel.

● PCL5c: View and change the PCL5c settings.

● PostScript: View and change the PS settings.

Networking tab

Provides the ability to change
network settings from your
computer.

Network administrators can use this tab to control network-related settings for the product
when it is connected to an IP-based network. This tab does not appear if the product is
directly connected to a computer.

HP Web Services tab Use this tab to set up and use various Web tools with the product.
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HP Utility for Mac OS X
Use the HP Utility for Mac OS X to view or change product settings from your computer. This tool opens
the HP Embedded Web Server for the product.

You can use the HP Utility when the product is connected with a USB cable or is connected to a TCP/IP-
based network.

Open the HP Utility

▲ From the dock, click HP Utility.

-or-

From Applications, click Hewlett Packard, and then click HP Utility.

HP Utility features

Use the HP Utility software to perform the following tasks:

● Obtain information about supplies status.

● Obtain information about the product, such as the firmware version and the serial number.

● Print a configuration page.

● Configure the paper type and size for the tray.

● Transfer files and fonts from the computer to the product.

● Update the product firmware.

● Display the color usage page.
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Product security features
The product supports security standards and recommended protocols that help you keep the product
secure, protect critical information on your network, and simplify the way you monitor and maintain the
product.

For in-depth information about HP's secure imaging and printing solutions, visit www.hp.com/go/
secureprinting. The site provides links to white papers and FAQ documents about security features.

Lock the product

1. You can attach a security cable to the slot on
the back of the product.

 

Set or change the product password

Use the HP Embedded Web Server to set a password or change an existing password for a product on
a network.

1. From the Home screen on the product control panel, touch the Network  button to find the
product IP address.

2. To open the HP Embedded Web Server, type the product IP address into the address line of a
Web browser.

NOTE: You can also access the HP Embedded Web Server from the HP Device Toolbox for
Windows or the HP Utility for Mac OS X.

3. Click the System tab, and click the Product Security link.

NOTE: If a password has previously been set, you are prompted to type the password. Type the
password, and then click the Apply button.

4. Type the new password in the Password box and in the Confirm Password box.

5. At the bottom of the window, click the Apply button to save the password.
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Economy settings

Print with EconoMode

This product has an EconoMode option for printing drafts of documents. Using EconoMode can use less
toner and decrease the cost per page. However, using EconoMode can also reduce print quality.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner
supply might outlast the mechanical parts in the print cartridge. If print quality begins to degrade and is
no longer acceptable, consider replacing the print cartridge.

NOTE: This feature is available with the PCL 6 printer driver for Windows. If you are not using that
driver, you can enable the feature by using the HP Embedded Web Server.

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the EconoMode check box.

Set the sleep delay

1. From the Home screen, touch the Setup  button.

2. Open the following menus:

● System Setup

● Energy Settings

● Sleep Delay

3. Select the time for the sleep delay.

NOTE: The default value is 15 Minutes.

Set the Auto Power Down delay

1. From the Home screen, touch the Setup  button.

2. Open the following menus:

● System Setup

● Energy Settings

● Auto Power Down

● Power Down Delay
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3. Select the time for the power-down delay.

NOTE: The default value is 30 Minutes.

4. The product automatically wakes from the auto power-down mode when it receives jobs or when
you press a button on the control panel. You can change which events cause the product to wake.
Open the following menus:

● System Setup

● Energy Settings

● Auto Power Down

● Wake Events

To turn off a wake event, select the event and then select the No option.
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Print when a print cartridge or imaging drum is at
estimated end of life

<Supply> Low message—where <Supply> is the color print cartridge or the imaging drum: The
product indicates when a supply level is low. Actual life remaining may vary. Consider having a
replacement available to install when print quality is no longer acceptable. The supply does not need to
be replaced now.

<Supply> Very Low message—where <Supply> is either the color print cartridge or imaging drum
or a combination of multiple print cartridges and/or the imaging drum: The product indicates when a
supply level is very low. Actual supply life remaining may vary. Consider having a replacement
available to install when print quality is no longer acceptable. The supply does not need to be replaced
now unless the print quality is no longer acceptable.

Once an HP print cartridge has reached “very low”, HP’s Premium Protection Warranty on that supply
has ended.

The imaging drum installed in this product is covered by the product warranty. Replacement imaging
drums have a one-year limited warranty from the date of installation. The imaging drum installation
date displays on the supplies status page.

You can change the way the product reacts when supplies reach the Very Low state. You do not have
to re-establish these settings when you install a new print cartridge or imaging drum.

1. From the Home screen on the control panel, touch the Setup  button.

2. Open the following menus:

● System Setup

● Supply Settings

● Black Cartridge, Color Cartridges, or Imaging Drum

● Very Low Setting

3. Select one of the following options:

● Select the Continue option to set the product to alert you that the print cartridge or imaging
drum is very low, but to continue printing.

When the Very Low Setting menu is set to the Continue option, the product automatically
continues printing when a supply reaches the recommended replacement level. The
<Supply> Very Low message appears while a supply is being used in continue at very
low mode.

Once an HP supply has reached very low, HP's Premium Protection Warranty on that supply
has ended. All print defects or cartridge failures incurred when an HP supply is used in
continue at very low mode will not be considered to be defects in materials or workmanship
in the supply under the HP Print Cartridge Warranty Statement.

● Select the Stop option to set the product to stop printing until you replace the print cartridge
or imaging drum.
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● Select the Prompt option to set the product to stop printing and prompt you to replace the
print cartridge or imaging drum. You can acknowledge the prompt and continue printing. A
customer configurable option on this product is "Prompt to Remind Me in 50 pages, 100
pages, 200 pages, or never." This option is provided as a customer convenience and is not
an indication these pages will have acceptable print quality.

● On the Color Cartridges menu only, select Print Black (the default option) to alert you when
the print cartridge is very low, but to continue printing in black only.
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Replace the print cartridges
CAUTION: Do not remove print cartridges from their packages until you are ready to use them.

1. Raise the camera arm to the fully open
position.

 

2. Remove the capture stage and set it aside.  

3. Open the print-cartridge door, and identify
which print cartridge is in the opening.

 

ENWW Replace the print cartridges 135



4. If the cartridge that you need to replace is not
in the opening, close the print-cartridge door.

 

5. From the Home screen on the product control
panel, touch the Supplies  button.

 

6. Touch the Cartridge Rotate button to move the
print-cartridge carousel to the next position. A
message informs you of which print cartridge
the carousel is rotating to. Repeat this step until
the print-cartridge carousel is in the correct
position.

NOTE: All doors must be closed when
pressing the Cartridge Rotate button. Also, the
imaging drum must be installed for the
Cartridge Rotate button to work.
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7. Wait until the Rotating message disappears
and the rotation sounds stop, and then open
the print-cartridge door.

 

8. Grasp the old print cartridge by the center
handle and remove it.

 

9. Remove the new print cartridge from the
packaging. Place the used print cartridge in
the bag and box for recycling.

CAUTION: To prevent damage to the print
cartridge, hold the print cartridge at each end.
Do not touch the roller on the print cartridge.

 

10. Grasp both sides of the new print cartridge
and gently rock it to distribute the toner evenly.
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11. Grasp the print cartridge by the center handle
and remove the protective plastic shield.

NOTE: Do not touch the print cartridge
roller. Fingerprints on the roller can cause
print-quality problems.

 

12. Remove the sealing tape from the print
cartridge. Place the tape in the print-cartridge
box to return for recycling.

 

13. Grasp the print cartridge by the center handle
and insert the print cartridge into the product.

NOTE: Compare the color label on the print
cartridge to the color label in the carousel slot
to make sure the print cartridge color matches
the carousel position. (The black carousel
position has no label.)

CAUTION: If toner gets on your clothing,
wipe it off with a dry cloth and wash the
clothing in cold water. Hot water sets toner
into the fabric.

 

14. Close the print cartridge door.

NOTE: After closing the print cartridge door,
the control panel shows the Calibrating...
message. Allow a few minutes for the product
to calibrate.

NOTE: If you need to replace another print
cartridge, you must close the print cartridge
door before touching the Cartridge Rotate
button again.

You do not need to wait for the product to
calibrate when replacing the second print
cartridge. Instead, touch the Cartridge Rotate
button to rotate the carousel into position. After
you have replaced the print cartridges, the
product calibrates.
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15. Reinstall the capture stage.  

16. Lower the camera arm.

NOTE: Lower the camera arm to protect the
camera lens cover from damage.
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Replace the imaging drum
NOTE: The imaging drum installed in this product is covered by the product warranty. Replacement
imaging drums have a one-year limited warranty from the date of installation. The imaging drum
installation date displays on the supplies status page. The HP Premium Protection Warranty applies only
to the print cartridges for the product.

CAUTION: Do not remove the imaging drum from its package until you are ready to use it.

1. Remove the paper from the input tray.  

2. Raise the camera arm to the fully open
position.
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3. Remove the capture stage and set it aside.  

4. Open the print-cartridge door.  

5. Pull the input tray straight out to remove it.  
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6. Pull out on the top right portion of the front
cover, and rotate it forward to release the right
side. Remove the front cover from the product.

 

7. Lift the two levers that hold the imaging drum.  

8. Remove the old imaging drum.  
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9. Remove the new imaging drum from the
packaging. Place the used imaging drum in
the bag and box for recycling.

 

10. Remove the protective shielding from the new
imaging drum.

CAUTION: To prevent damage, do not
expose the imaging drum to light. Cover it with
a piece of paper.

CAUTION: Do not touch the green roller.
Fingerprints on the imaging drum can cause
print-quality problems.

 

11. Insert the new imaging drum in the product.  

12. Lower the two levers that hold the imaging
drum.
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13. Reinstall the front cover. Insert the left side first,
and then rotate the cover into place.

 

14. Reinstall the input tray.  

15. Close the print-cartridge door.  
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16. Reinstall the capture stage.  

17. Lower the camera arm.

NOTE: Lower the camera arm to protect the
camera lens cover from damage.
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18. Load the paper in the input tray.  

19. Adjust the guides until they are snug against
the paper.
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Update the firmware
HP offers periodic upgrades to the product firmware. You can load the firmware updates manually, or
you can set the product to automatically load firmware updates.

Manually update the firmware

1. From the Home screen on the control panel, touch the Setup  button.

2. Open the following menus:

● Service

● LaserJet Update

● Check For Updates Now

3. Touch the Yes button to prompt the product to search for firmware updates. If the product detects
an upgrade, it will begin the update process.

Set the product to automatically update the firmware

1. From the Home screen on the control panel, touch the Setup  button.

2. Open the following menus:

● Service

● LaserJet Update

● Manage Updates

● Prompt Before Install

3. Touch the Install Automatically option.
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8 Solve problems

● Solve problems checklist

● Restore the factory-set defaults

● Control panel help system

● Paper feeds incorrectly or becomes jammed

● Clear jams

● Improve print quality

● Improve copy quality

● Solve scan to email problems

● Solve scan to network folder problems

● The product prints slowly

● Solve USB connection problems

● Solve wired network problems

● Solve wireless network problems

● Solve product software problems with Windows

● Solve product software problems with Mac OS X

● Remove software (Windows)

● Remove software (Mac OS X)
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Solve problems checklist
Follow these steps when trying to solve a problem with the product.

● Step 1: Make sure that the product is set up correctly

● Step 2: Check the cabling or wireless connection

● Step 3: Check the control panel for error messages

● Step 4: Check the paper

● Step 5: Check the software

● Step 6: Test print functionality

● Step 7: Test copy functionality

● Step 8: Check the supplies

● Step 9: Try sending a print job from a computer

Step 1: Make sure that the product is set up correctly

1. Press the power button to turn on the product or to deactivate the Auto-Off mode.

2. Check the power-cable connections.

3. Make sure that the line voltage is correct for the product power configuration. (See the label that is
inside the product front cover for voltage requirements.) If you are using a power strip and its
voltage is not within specifications, plug the product directly into the wall. If it is already plugged
into the wall, try a different outlet.

4. If none of these measures restores power, contact HP Customer Care.

Step 2: Check the cabling or wireless connection

1. Check the cable connection between the product and the computer. Make sure that the connection
is secure.

2. Make sure that the cable itself is not faulty by using a different cable, if possible.

3. If the product is connected to a network, check the following items:

● Check the light next to the network connection on the product. If the network is active, the
light is green.

● Make sure that you are using a network cable and not a phone cord to connect to the
network.
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● Make sure the network router, hub, or switch is turned on and that it is working correctly.

● If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.

4. If you are using a personal firewall system on the computer, it might be blocking communication
with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

Step 3: Check the control panel for error messages

The control panel should indicate ready status. If an error message appears, resolve the error.

Step 4: Check the paper

1. Make sure that the paper that you are using meets specifications.

2. Make sure that the paper is loaded correctly in the input tray.

Step 5: Check the software

1. Make sure that the product software is installed correctly.

2. Verify that you have installed the printer driver for this product. Check the program to make sure
that you are using the printer driver for this product.

Step 6: Test print functionality

1. Print a configuration page.

2. If the page does not print, verify that the input tray contains paper.

3. If the page jams in the product, clear the jam.

Step 7: Test copy functionality

1. Place the configuration page onto the capture stage and make a copy.

2. If the print quality on the copied pages is not acceptable, clean the cover over the camera lens
with a soft cloth or sponge that has been moistened with nonabrasive glass cleaner.

CAUTION: Do not use abrasives, acetone, benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these can damage the product. Do not place liquids
directly on the capture stage. They might seep and damage the product.

Step 8: Check the supplies

Print a supplies status page and check remaining life of the print cartridges and imaging drum.
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Step 9: Try sending a print job from a computer

1. Try printing the job from another computer that has the product software installed.

2. Check the USB or network cable connection. Direct the product to the correct port, or reinstall the
software, selecting the connection type that you are using.

3. If the print quality is unacceptable, verify that the print settings are correct for the media that you
are using.
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Restore the factory-set defaults 
1. On the product control panel, touch the Setup  button.

2. Scroll to and touch the Service menu.

3. Scroll to and touch the Restore Defaults button, and then touch the OK button.

The product automatically restarts.
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Control panel help system
The product has a built-in Help system that explains how to use each screen. To open the Help system,
touch the Help  button in the upper-right corner of the screen.

For some screens, the Help opens to a global menu where you can search for specific topics. You can
browse through the menu structure by touching the buttons in the menu.

Some Help screens include animations that guide you through procedures, such as clearing jams.

For screens that contain settings for individual jobs, the Help opens to a topic that explains the options
for that screen.

If the product alerts you of an error or warning, touch the Help  button to open a message that
describes the problem. The message also contains instructions to help solve the problem.
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Paper feeds incorrectly or becomes jammed

The product does not pick up paper

If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

3. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

4. Check the product control panel to see if the product is waiting for you to acknowledge a prompt
to feed the paper manually. Load paper, and continue.

The product picks up multiple sheets of paper

If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not
fan the paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

Prevent paper jams

To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.

2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

3. Use paper that has not previously been printed or copied on.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

6. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and
feed sheets one at a time.

ENWW Paper feeds incorrectly or becomes jammed 155



Clear jams

Jam locations

Jams can occur in these locations:

1

3

2

1 Output bin

2 Rear door

3 Input tray

Loose toner might remain in the product after a jam. This problem typically resolves itself after a few
sheets have been printed.

Clear jams from the input tray

1. Remove the paper from the input tray.  
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2. With both hands, grasp the paper, and
carefully pull it free from the product.

NOTE: If the sheet tears, remove all
fragments before continuing. Do not use sharp
objects to remove fragments.

 

3. Raise the camera arm to the fully open
position.

 

4. Remove the capture stage and set it aside.  
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5. Open and close the print cartridge door to
reset the product.

 

6. Reinstall the capture stage.  

7. Lower the camera arm.

NOTE: Lower the camera arm to protect the
camera lens cover from damage.
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Clear jams from the output bin

1. Raise the camera arm to the fully open
position.

 

2. Remove the capture stage and set it aside.  

3. With both hands, grasp the paper, and
carefully pull it free from the product.

NOTE: If the sheet tears, remove all
fragments before continuing. Do not use sharp
objects to remove fragments.
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4. Reinstall the capture stage.  

5. Lower the camera arm.

NOTE: Lower the camera arm to protect the
camera lens cover from damage.

 

Clear jams from the rear door

1. Open the rear door.

CAUTION: The fuser is located above the
rear door, and it is hot. Do not attempt to
reach into the area above the rear door until
the fuser is cool.
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2. With both hands, grasp the paper, and
carefully pull it free from the product.

NOTE: If the sheet tears, remove all
fragments before continuing. Do not use sharp
objects to remove fragments.

 

3. Close the rear door.  
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Improve print quality

Check the paper type setting (Windows)

Check the paper type setting if you are having any of the following problems:

● Toner is smearing on the printed pages.

● Repeated marks occur on the printed pages.

● Printed pages are curled.

● Toner flakes off the printed pages.

● Printed pages have small unprinted areas.

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Type is drop-down list, click the More... option.

5. Expand the list of Type is options.

6. Expand each category of paper types until you find the paper type that you are using.

7. Select the option for the type of paper you are using, and then click the OK button.

Check the paper type setting (Mac OS X)

Check the paper type setting if you are having any of the following problems:

● Toner is smearing on the printed pages.

● Repeated marks occur on the printed pages.

● Printed pages are curled.

● Toner flakes off the printed pages.

● Printed pages have small unprinted areas.

1. On the File menu, click the Print option.

2. In the Printer menu, select this product.

3. In the Copies & Pages menu, click the Page Setup button.

4. Select a size from the Paper Size drop-down list, and then click the OK button.

5. Open the Finishing menu.
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6. Select a type from the Media-type drop-down list.

7. Click the Print button.

Use paper that meets HP specifications

Use different paper if you are having any of the following problems:

● The printing is too light or seems faded in areas.

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Printed characters seem misformed.

● Printed pages are curled.

Always use a paper type and weight that this product supports. In addition, follow these guidelines
when selecting paper:

● Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust,
wrinkles, voids, staples, and curled or bent edges.

● Use paper that has not been previously printed on.

● Use paper that is designed for use in laser printers. Do not use paper that is designed only for use
in Inkjet printers.

● Use paper that is not too rough. Using smoother paper generally results in better print quality.

Print a cleaning page

Print a cleaning page to remove dust and excess toner from the paper path if you are having any of the
following problems:

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Repeated marks occur on the printed pages.

Use the following procedure to print a cleaning page.

1. From the Home screen, touch the Setup  button.

2. Touch the Service menu.

3. Touch the Cleaning Page button.

4. Load plain letter or A4 paper when you are prompted.

5. Touch the OK button to begin the cleaning process.

A page feeds through the product slowly. Discard the page when the process is completed.
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Calibrate the product to align the colors

If the printed output has colored shadows, blurry graphics, or areas that have poor color, you might
need to calibrate the product to align the colors. Print the diagnostics page from the Reports menu on
the control panel to check the color alignment. If the blocks of color on that page are not aligned with
each other, you need to calibrate the product.

1. On the product control panel, open the System Setup menu.

2. Open the Print Quality menu, and select the Color Calibration item.

3. Select the Calibrate Now option.

Check the estimated remaining life for the print cartridges and
imaging drum

Check each print cartridge, and replace it if necessary, if you are having any of the following
problems:

● The printing is too light or seems faded in areas.

● Printed pages have small unprinted areas.

● Printed pages have streaks or bands.

NOTE: If you are using a draft print setting, the printing might appear light.

The supplies status page indicates the estimated life remaining in print cartridges and the imaging
drum. It also lists the part number for the correct genuine HP print cartridges and imaging drum for your
product so you can order replacements.

1. On the product control panel, open the Reports menu.

2. Select the Supplies Status page to print it.

Interpret the Print Quality Page

1. On the product control panel, open the Reports menu.

2. Select the Print Quality Page item to print it.

This page contains five bands of color, which are divided into four groups as indicated in the following
illustration. By examining each group, you can isolate the problem to a particular print cartridge.
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Section Print-cartridge

1 Yellow

2 Cyan

3 Black

4 Magenta

● If dots or streaks appear in only one of the groups, replace the print cartridge that correlates with
that group.

● If dots appear in more than one group, print a cleaning page. If this does not solve the problem,
determine if the dots are always the same color; for example, if magenta dots appear in all five
color bands. If the dots are all the same color, replace that print cartridge.

● If streaks appear in multiple color bands, contact HP. A component other than the print cartridge is
probably causing the problem.

Inspect the print cartridges and imaging drum for damage

1. Remove the print cartridge from the product, and examine it for damage. Locate the memory tag
on the end of the print cartridge and make sure it is not damaged.

1

2

1 Print cartridge memory tag

2. If the print cartridge does not appear to be damaged, rock the print cartridge gently several times
and reinstall it. Print a few pages to see if the problem is resolved.
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3. If the problem is not resolved, remove the imaging drum from the product, and examine the
surface.

CAUTION: Do not touch the green roller. Fingerprints on the imaging drum can cause print-
quality problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the imaging
drum.

5. Locate the memory tag on the imaging drum, and make sure it is not damaged.

1

1 Imaging drum memory tag

Fix defects that repeat on the page

If defects repeat at any of the following intervals on the page, a print cartridge or the imaging drum
might be damaged.

● 22 mm (print cartridge)

● 26 mm (imaging drum)

● 29 mm (print cartridge)

● 94 mm (imaging drum)
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Improve copy quality
If print quality problems occur only in copied documents, try these solutions.

● Make sure the copy settings on the product control panel are adjusted for the type of document
and paper you are using.

● Make sure the camera arm is raised completely.

NOTE: Do not touch the camera arm during the copy process. Due to its sensitivity, camera-arm
movement can cause image quality problems.

Clean the camera lens cover

If the print quality on the copied pages is not acceptable, clean the cover over the camera lens with a
soft cloth or sponge that has been moistened with nonabrasive glass cleaner.

CAUTION: Do not use abrasives, acetone, benzene, ammonia, ethyl alcohol, or carbon tetrachloride
on any part of the product; these can damage the product. Do not place liquids directly on the capture
stage. They might seep and damage the product.

Clean the capture stage

If the image quality on copied or scanned images is not acceptable, clean the capture stage with a soft
cloth that has been moistened with water and a mild detergent. If there are still image problems after
cleaning, clean the capture stage again using a soft cloth and glass cleaner.

CAUTION: Do not remove or damage the four black dots located near the corners on the surface of
the capture stage. These dots are used to align the camera to the capture stage.

CAUTION: Do not spray water or cleaners directly onto the capture stage. Spray the clean cloth first,
and then clean the capture stage.

CAUTION: Do not use abrasives, acetone, benzene, ammonia, ethyl alcohol, or carbon tetrachloride
on any part of the product; these can damage the product.

Solve problems with cropped copies

The product cannot print fully edge-to-edge. The maximum printing area is 203.2 x 347 mm (8 x
13.7 in), leaving a 4 mm (1/6 in) unprintable border around the page.

● When the original is smaller than the output size, move the original 4 mm (1/6 in) away from the
corner of the capture stage. Recopy in this position.

● When the original is the size of the desired output, use the Reduce/Enlarge feature to reduce the
image so the copy is not cropped.

Solve problems with glare in copies

If you are making a copy of a document and there is too much glare, change the Capture mode.
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1. Raise the camera arm to the fully open
position.

 

2. Place the document or object on the capture
stage, facing up. Align the top left corner of
documents with the ridges along the right and
rear edges of the capture stage.

 

3. From the Home screen, touch the Copy button.  
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4. Touch the arrows to scroll through the Capture
options, and select the Document option.

 

5. Touch the Black or Color button to start
copying.

 

If you are making a copy of an object and there is too much glare, try moving the object to another
part of the capture stage. When objects are placed directly under the camera, the copied or scanned
output is more likely to have glare.
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Solve scan to email problems
If scan to email problems occur, try these solutions:

● Make sure this feature has been set up. If this feature has not been set up, use the setup wizard in
the HP Device Toolbox (Windows) or HP Utility for Mac OS X software to set it up.

● Make sure the Scan to Email feature is enabled. If it has been disabled, enable the feature through
the HP Device Toolbox (Windows) or HP Utility for Mac OS X software.

● Make sure the product is connected to a computer or to a network.

Cannot connect to the email server

● Make sure the SMTP server name is correct. Check this setting with your system administrator or
Internet Service Provider.

● If the product cannot establish a secure connection to the SMTP server, try without the secure
connection or try a different server or port. Check this setting with your system administrator or
Internet Service Provider.

● If the SMTP server requires authentication, make sure a valid user name and password are used.

● If the SMTP server uses an authentication method that is not supported, try a different server.
Check this setting with your system administrator or Internet Service Provider.

The email failed

● Verify that email addresses entered are correct.

● If the size of the email was too large, send fewer pages or reduce the scan resolution.

Unable to scan

● If you are prompted for a PIN, enter the correct PIN for the outgoing profile.

● Make sure at least one email address is selected in the To field.
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Solve scan to network folder problems
If scan to network folder problems occur, try these solutions:

● Make sure this feature has been set up. If this feature has not been set up, use the setup wizard in
the HP Device Toolbox (Windows) or HP Utility for Mac OS X software to set it up.

● Make sure the Scan to Network Folder feature is enabled. If it has been disabled, enable the
feature through the HP Device Toolbox (Windows) or HP Utility for Mac OS X software.

● Make sure the product is connected to a network.

The scan failed

● Make sure the network path is in the correct format (//host/share/path) and the folder exists.

● Make sure the network directory is readable and writeable.

● If you are using the default file names for scanned files, make sure there are no conflicting file
names. Remove some of the previously scanned files.

● Use the IP address instead of the host name. Make sure the product and host are connected to the
same network.

● If the network folder is password protected, make sure to enter the correct user name and
password.

● If a Disk full message displays, remove some files from the network folder.

● Turn the product off, and then on. Scan again.
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The product prints slowly
Several factors affect the time it takes to print a job:

● The use of special paper (such as transparencies, heavy paper, and custom-size paper)

● Print quality settings in the printer driver

● Product processing and download time

● The complexity and size of graphics

● The speed of the computer you are using

● The USB or network connection

● The product I/O configuration

If the product prints, but it seems slow, try the following solutions.

1. Make sure the computer meets the minimum specifications for this product. For a list of
specifications, go to this Web site: www.hp.com/support/LJColorMFPM275nw.

2. When you configure the product to print on some paper types, such as heavy paper, the product
prints more slowly so it can correctly fuse the toner to the paper. If the paper type setting is not
correct for the type of paper you are using, change the setting to the correct paper type.

3. When you configure the product to print at a high level of print quality, the product prints more
slowly. Change the print quality settings to change the print speed.

4. If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.

5. The product might be in cool-down mode. Wait for the product to cool.
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Solve USB connection problems
If you have connected the product directly to a computer, check the cable.

● Verify that the cable is connected to the computer and to the product.

● Verify that the cable is not longer than 5 m (16.4 ft). Try using a shorter cable.

● Verify that the cable is working correctly by connecting it to another product. Replace the cable if
necessary.
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Solve wired network problems
Check the following items to verify that the product is communicating with the network. Before
beginning, print a configuration page from the product control panel and locate the product IP address
that is listed on this page.

● Poor physical connection

● The computer is using the incorrect IP address for the product

● The computer is unable to communicate with the product

● The product is using incorrect link and duplex settings for the network

● New software programs might be causing compatibility problems

● The computer or workstation might be set up incorrectly

● The product is disabled, or other network settings are incorrect

NOTE: HP does not support peer-to-peer networking, as the feature is a function of Microsoft
operating systems and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.

Poor physical connection

1. Verify that the product is attached to the correct network port using a cable of the correct length.

2. Verify that cable connections are secure.

3. Look at the network port connection on the back of the product, and verify that the amber activity
light and the green link-status light are lit.

4. If the problem continues, try a different cable or port on the hub.

The computer is using the incorrect IP address for the product

1. Open the printer properties and click the Ports tab. Verify that the current IP address for the
product is selected. The product IP address is listed on the product configuration page.

2. If you installed the product using the HP standard TCP/IP port, select the box labeled Always
print to this printer, even if its IP address changes.

3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of
the IP address.

4. If the IP address is correct, delete the product and then add it again.
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The computer is unable to communicate with the product

1. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and
then type cmd.

b. Type ping followed by the IP address for your product.

For Mac OS X, open the Network Utility, and then supply the IP address in the correct field in
the Ping pane.

c. If the window displays round-trip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network
settings, the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the
network

Hewlett-Packard recommends leaving this setting in automatic mode (the default setting). If you change
these settings, you must also change them for your network.

New software programs might be causing compatibility problems

Verify that any new software programs are correctly installed and that they use the correct printer
driver.

The computer or workstation might be set up incorrectly

1. Check the network drivers, printer drivers, and the network redirection.

2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect

1. Review the configuration page to check the status of the network protocol. Enable it if necessary.

2. Reconfigure the network settings if necessary.
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Solve wireless network problems

Wireless connectivity checklist

● Verify that the network cable is not connected.

● Verify that the product and the wireless router are turned on and have power. Also make sure that
the wireless radio in the product is turned on.

● Verify that the service set identifier (SSID) is correct. Print a configuration page to determine the
SSID. If you are not sure the SSID is correct, run the wireless setup again.

● With secured networks, verify that the security information is correct. If the security information is
incorrect, run the wireless setup again.

● If the wireless network is working correctly, try accessing other computers on the wireless network.
If the network has Internet access, try connecting to the Internet over a wireless connection.

● Verify that the encryption method (AES or TKIP) is the same for the product as it is for the wireless
access point (on networks using WPA security).

● Verify that the product is within the range of the wireless network. For most networks, the product
must be within 30 m (100 ft) of the wireless access point (wireless router).

● Verify that obstacles do not block the wireless signal. Remove any large metal objects between the
access point and the product. Make sure poles, walls, or support columns containing metal or
concrete do not separate the product and wireless access point.

● Verify that the product is located away from electronic devices that might interfere with the
wireless signal. Many devices can interfere with the wireless signal including motors, cordless
phones, security system cameras, other wireless networks, and some Bluetooth devices.

● Verify that the printer driver is installed on the computer.

● Verify that you have selected the correct printer port.

● Verify that the computer and product connect to the same wireless network.

The product does not print after the wireless configuration
completes

1. Make sure that the product is turned on and in the ready state.

2. Turn off any third-party firewalls on your computer.

3. Make sure that the wireless network is working correctly.

4. Make sure that your computer is working correctly. If necessary, restart the computer.
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The product does not print, and the computer has a third-party
firewall installed

1. Update the firewall with the most recent update available from the manufacturer.

2. If programs request firewall access when you install the product or try to print, make sure you
allow the programs to run.

3. Temporarily turn off the firewall, and then install the wireless product on the computer. Enable the
firewall when you have completed the wireless installation.

The wireless connection does not work after moving the wireless
router or product

Make sure that the router or product connects to the same network that your computer connects to.

1. Print a configuration page.

2. Compare the service set identifier (SSID) on the configuration page to the SSID in the printer
configuration for the computer.

3. If the numbers are not the same, the devices are not connecting to the same network. Reconfigure
the wireless setup for the product.

Cannot connect more computers to the wireless product

1. Make sure that the other computers are within the wireless range and that no obstacles block the
signal. For most networks, the wireless range is within 30 m (100 ft) of the wireless access point.

2. Make sure that the product is turned on and in the ready state.

3. Turn off any third-party firewalls on your computer.

4. Make sure that the wireless network is working correctly.

5. Make sure that your computer is working correctly. If necessary, restart the computer.

The wireless product loses communication when connected to a
VPN

● Typically, you cannot connect to a VPN and other networks at the same time.

The network does not appear in the wireless networks list

● Make sure the wireless router is turned on and has power.

● The network might be hidden. However, you can still connect to a hidden network.
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The wireless network is not functioning

1. Make sure that the network cable is not connected.

2. To verify if the network has lost communication, try connecting other devices to the network.

3. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and
then type cmd.

b. Type ping followed by the router IP address.

For Mac OS X, open the Network Utility, and then supply the IP address in the correct field in
the Ping pane.

c. If the window displays round-trip times, the network is working.

4. Make sure that the router or product connects to the same network that the computer connects to.

a. Print a configuration page.

b. Compare the service set identifier (SSID) on the configuration report to the SSID in the printer
configuration for the computer.

c. If the numbers are not the same, the devices are not connecting to the same network.
Reconfigure the wireless setup for the product.

Perform a wireless network diagnostic test

From the product control panel, you can run a diagnostic test that provides information about the
wireless network settings.

1. From the Home screen, touch the Setup  button.

2. Open the following menus

● System Setup

● Self Diagnostics

3. Touch the Run Network Test button to start the test. The product prints a test page that shows test
results.
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Reduce interference on a wireless network

The following tips can reduce interference in a wireless network:

● Keep the wireless devices away from large metal objects, such as filing cabinets, and other
electromagnetic devices, such as microwaves and cordless telephones. These objects can disrupt
radio signals.

● Keep the wireless devices away from large masonry structures and other building structures. These
objects can absorb radio waves and lower signal strength.

● Position the wireless router in a central location in line of sight with the wireless products on the
network.
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Solve product software problems with Windows

A printer driver for the product is not visible in the Printer folder

1. Reinstall the product software.

NOTE: Close any applications that are running. To close an application that has an icon in the
system tray, right-click the icon, and select Close or Disable.

2. Try plugging the USB cable into a different USB port on the computer.

An error message was displayed during the software installation

1. Reinstall the product software.

NOTE: Close any applications that are running. To close an application that has an icon in the
system tray, right-click the icon, and select Close or Disable.

2. Check the amount of free space on the drive where you are installing the product software. If
necessary, free up as much space as you can, and reinstall the product software.

3. If necessary, run the Disk Defragmenter, and reinstall the product software.

The product is in Ready mode, but nothing prints

1. Print a configuration page, and verify the product functionality.

2. Verify that all of the cables are correctly seated and within specifications. This includes the USB
and power cables. Try a new cable.

3. Verify the IP address on the configuration page matches the IP address for the software port. Use
one of the following procedures:

Windows XP, Windows Server 2003, Windows Server 2008, and Windows Vista

a. Click Start.

b. Click Settings.

c. Click Printers and Faxes (using the default Start menu view) or click Printers (using the
Classic Start menu view).

d. Right-click the product driver icon, and then select Properties.

e. Click the Ports tab, and then click Configure Port.

f. Verify the IP address, and then click OK or Cancel.

g. If the IP addresses are not the same, delete the driver, and reinstall the driver using the
correct IP address.
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Windows 7

a. Click Start.

b. Click Devices and Printers.

c. Right-click the product driver icon, and then select Printer properties.

d. Click the Ports tab, and then click Configure Port.

e. Verify the IP address, and then click OK or Cancel.

f. If the IP addresses are not the same, delete the driver, and reinstall the driver using the
correct IP address.

ENWW Solve product software problems with Windows 181



Solve product software problems with Mac OS X
● The printer driver is not listed in the Print & Fax list

● The product name does not appear in the product list in the Print & Fax list

● The printer driver does not automatically set up the selected product in the Print & Fax list

● A print job was not sent to the product that you wanted

● When connected with a USB cable, the product does not appear in the Print & Fax list after the
driver is selected.

● You are using a generic printer driver when using a USB connection

The printer driver is not listed in the Print & Fax list

1. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/
PPDs/Contents/Resources. If necessary, reinstall the software.

2. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

The product name does not appear in the product list in the Print &
Fax list

1. Make sure that the cables are connected correctly and the product is on.

2. Print a configuration page to check the product name. Verify that the name on the configuration
page matches the product name in the Print & Fax list.

3. Replace the USB or network cable with a high-quality cable.

The printer driver does not automatically set up the selected
product in the Print & Fax list

1. Make sure that the cables are connected correctly and the product is on.

2. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/
PPDs/Contents/Resources. If necessary, reinstall the software.

3. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

4. Replace the USB or network cable with a high-quality cable.
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A print job was not sent to the product that you wanted

1. Open the print queue and restart the print job.

2. Another product with the same or similar name might have received your print job. Print a
configuration page to check the product name. Verify that the name on the configuration page
matches the product name in the Print & Fax list.

When connected with a USB cable, the product does not appear in
the Print & Fax list after the driver is selected.

Software troubleshooting

▲ Make sure that your Mac operating system is Mac OS X 10.5 or later.

Hardware troubleshooting

1. Make sure that the product is turned on.

2. Make sure that the USB cable is connected correctly.

3. Make sure that you are using the appropriate high-speed USB cable.

4. Make sure that you do not have too many USB devices drawing power from the chain. Disconnect
all of the devices from the chain, and then connect the cable directly to the USB port on the
computer.

5. Check to see if more than two non-powered USB hubs are connected in a row on the chain.
Disconnect all of the devices from the chain, and then connect the cable directly to the USB port
on the computer.

NOTE: The iMac keyboard is a non-powered USB hub.

You are using a generic printer driver when using a USB
connection

If you connected the USB cable before you installed the software, you might be using a generic printer
driver instead of the driver for this product.

1. Delete the generic printer driver.

2. Reinstall the software from the product CD. Do not connect the USB cable until the software
installation program prompts you.

3. If multiple printers are installed, make sure that you have selected the correct printer in the
Format For drop-down menu in the Print dialog box.
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Remove software (Windows)

Windows XP

1. Click Start, and then click Programs.

2. Click HP, and then click the product name.

3. Click Uninstall, and then follow the onscreen instructions to remove the software.

Windows Vista and Windows 7

1. Click Start, and then click All Programs.

2. Click HP, and then click the product name.

3. Click Uninstall, and then follow the onscreen instructions to remove the software.
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Remove software (Mac OS X)
You must have administrator rights to remove the software.

1. Disconnect the product from the computer.

2. Open Applications.

3. Select Hewlett Packard.

4. Select HP Uninstaller.

5. Select the product from the list of devices, and then click the Uninstall button.

6. After the software is uninstalled, restart the computer and empty the Trash.
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9 Supplies and accessories

● Order parts, accessories, and supplies

● HP policy on non-HP supplies

● HP anticounterfeit Web site
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Order parts, accessories, and supplies

HP original print cartridge, imaging drum, and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.

Item Part number Cartridge number Description

HP LaserJet print cartridge CE310A 126A Black print cartridge with HP
ColorSphere toner

CE311A 126A Cyan print cartridge with HP
ColorSphere toner

CE312A 126A Yellow print cartridge with HP
ColorSphere toner

CE313A 126A Magenta print cartridge with HP
ColorSphere toner

Imaging drum CE314A  Replacement imaging drum

USB 2.0 printer cable C6518A  (2-meter standard) A-to-B cable

NOTE: The imaging drum installed in this product is covered by the product warranty. Replacement
imaging drums have a one-year limited warranty from the date of installation. The imaging drum
installation date displays on the supplies status page. HP's Premium Protection Warranty applies only to
the print cartridges for the product.

HP policy on non-HP supplies
Hewlett-Packard Company cannot recommend the use of non-HP print cartridges and imaging drums,
either new or remanufactured.

NOTE: For HP printer products, the use of a non-HP print cartridge or a refilled print cartridge does
not affect either the warranty to the customer or any HP support contract with the customer. However, if
product failure or damage is attributable to the use of a non-HP print cartridge or refilled print
cartridge, HP will charge its standard time and materials charges to service the product for the
particular failure or damage.

HP anticounterfeit Web site
Go to www.hp.com/go/anticounterfeit when you install an HP print cartridge and the control-panel
message says the cartridge is non-HP. HP will help determine if the cartridge is genuine and take steps
to resolve the problem.
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Your print cartridge might not be a genuine HP print cartridge if you notice the following:

● The supplies status page indicates that a non-HP supply is installed.

● You are experiencing a high number of problems with the print cartridge.

● The cartridge does not look like it usually does (for example, the packaging differs from
HP packaging).
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A
accessories

ordering 187, 188
AirPrint 62
anticounterfeit supplies 188
applications

downloading 123
Apps menu 123
archival-quality printing 60

B
bin, output

jams, clearing 159
locating 6

booklets
printing (Mac) 51
printing (Windows) 49

C
camera lens cover

cleaning 167
camera, locating 6
canceling

print job (Mac) 58
print job (Windows) 58

capture stage
cleaning 167

capture stage, locating 6
cartridges

non-HP 188
part numbers 188
supplies status page 12

cleaning
camera lens cover 167
capture stage 167
paper path 163

collating copies 73
color

Edge Control 56

halftone options 56
matching 57
Neutral Grays 56
printed vs. monitor 57

color alignment, calibrating 164
color options

changing manually 56
HP EasyColor 54
setting (Mac) 53
setting (Windows) 52

color or black and white
copying 85

color theme
changing (Windows) 55

color usage log 12
configuration page 12
contrast settings

copy 93
control panel

buttons and lights 9
help 154
Home screen 10
locating 6
menu map, printing 12
Reports menu 12

copy quality, improving 167
copying

adjusting image quality 96
collation 73
color or black and white 85
contrast, adjusting 93
double-sided 78
draft mode 100
edge-to-edge 167
enlarging 82
light/dark settings 93
multiple copies 66
multiple-page originals 69
paper size and type 104

quality, adjusting 90
reducing 82
restore default settings 110
set new default settings 108
single copies 64

counterfeit supplies 188
custom-size copies 82

D
darkness, contrast settings

copy 93
default copy settings

changing 108
restoring to factory settings

110
default gateway, setting 124
defaults, restoring 153
defects, repeating 166
door release, locating 6
draft mode, copying 100
drivers

changing settings (Mac) 24
changing settings (Windows)

22
presets (Mac) 31, 32
settings (Mac) 31, 32
usage page 12

duplex printing
Mac 35
Windows 33

duplex settings, changing 126

E
EconoMode setting 131
economy settings 131
Edge Control 56
edge-to-edge printing 167
email

scanning to 119
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Embedded Web Server
changing network settings 124
changing password 130
changing product name 125
opening 124, 125, 130

enlarging documents
copying 82

errors
software 180

F
factory-set defaults, restoring 153
folders

scanning to network 118
fonts

lists, printing 12
fraud Web site 188
front cover, locating 6

G
gateway, setting default 124
grayscale printing, Windows 60

H
help, control panel 154
Home screen, control panel 10
HP Device Toolbox, using 127
HP Easy Color

disabling 54
using 54

HP Embedded Web Server
changing network settings 124
changing password 130
changing product name 125
opening 124, 125, 130

HP ePrint, using 61
HP fraud Web site 188
HP Reconfiguration Utility

network installation 122
HP Scan software (Mac) 115
HP Scan software (Windows) 114
HP Utility for Mac

features 129
opening 129

HP Utility, Mac 129
HP Web Services

applications 123
enabling 123

HP Web Services, enabling 61

I
identification cards

copying 87
imaging drum

checking for damage 165
estimated remaining life 164
low threshold settings 133
part number 188
recycling 140
replacing 140
using when low 133

input tray
loading 17
locating 6

interface ports
locating 7

IPv4 address 124

J
jams

locating 156
output bin, clearing 159
preventing 155
rear door, clearing 160
tracking number of 12
trays, clearing 156

L
landscape orientation

changing (Mac) 40
changing (Windows) 39

lightness
copy contrast 93

link speed settings 126
loading paper

input tray 17
orientation 18
tray capacity 18

lock
product 130

M
Mac

driver settings 24, 31, 32
HP Utility 129
problems, troubleshooting 182
scanning from TWAIN-

compliant software 116
managing network 124
matching colors 57

menus, control panel
map, printing 12

model number, locating 8
multiple pages per sheet

printing (Mac) 38
printing (Windows) 36

multiple-page originals
copying 69

N
network

password, changing 130
password, setting 130
product name, changing 125
settings, changing 124
settings, viewing 124

network port
locating 7

networks
configuration page 12
default gateway 124
installing the product 122
IPv4 address 124
settings report 12
subnet mask 124

Neutral Grays 56
nework folder

scanning to 118
non-HP supplies 188
number of copies, changing 66

O
OCR software 116
online help, control panel 154
optical character recognition

software 116
ordering

supplies and accessories 188
ordering supplies

Web sites 187
orientation

changing (Mac) 40
changing (Windows) 39

output bin
locating 6

P
page count 12
page orientation

changing (Mac) 40
changing (Windows) 39
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page sizes
scaling documents to fit (Mac)

48
scaling documents to fit

(Windows) 47
pages per sheet

selecting (Mac) 38
selecting (Windows) 36

paper
jams 155
ordering 188
selecting 163
supported sizes 14
supported types 15

paper jams. See jams
paper orientation

loading paper 18
paper pickup problems

solving 155
paper sizes

copy settings 104
selecting (Mac) 59
selecting (Windows) 59
selecting custom sizes (Mac)

59
selecting custom sizes

(Windows) 59
paper types

copy settings 104
selecting (Mac) 43
selecting (Windows) 41

paper, covers
printing (Mac) 46
printing (Windows) 44

part numbers
imaging drum 188
print cartridges 188

PCL font list 12
portrait orientation

changing (Mac) 40
changing (Windows) 39

ports
locating 7

power-down delay
setting 131

presets (Mac) 31, 32
print cartridges

checking for damage 165
door release, locating 6
estimated remaining life 164

low threshold settings 133
non-HP 188
part numbers 188
recycling 135
replacing 135
supplies status page 12
using when low 133

print job
canceling (Mac) 58
canceling (Windows) 58

print on both sides
Mac 35
Windows 33

print quality
improving 162

print quality page
interpreting 164
printing 164

printer driver (Windows)
supported 21

printer drivers (Mac)
changing settings 24
settings 31, 32

printer drivers (Windows)
changing settings 22

printing
edge-to-edge 167
product reports 12
settings (Mac) 31, 32

problem-solving
slow response 172

PS font list 12

R
Readiris OCR software 116
rear door

jams 160
locating 7

reducing documents
copying 82

repeating defects,
troubleshooting 166

repetitive print defects,
troubleshooting 166

reports
Color Usage Log 12
Configuration Report 12
Demo Page 12
Diagnostics Page 12
Menu Structure 12

Network Summary 12
PCL Font List 12
PCL6 Font List 12
Print Quality Page 12
PS Font List 12
Service Page 12
Supplies Status 12
Usage Page 12

Reports menu 12
resize documents

copying 82
Mac 48
Windows 47

restoring factory-set defaults 153

S
scale documents

Mac 48
Windows 47

scaling documents
copying 82

scanning
from HP Scan software (Mac)

115
from HP Scan software

(Windows) 114
OCR software 116
to email 119
to email, setup 117
to network folder 118
to network folder, setup 117
TWAIN-compliant software

116
WIA-compliant software 116

serial number, locating 8
service page 12
settings

driver presets (Mac) 31, 32
drivers 22
drivers (Mac) 24
factory-set defaults, restoring

153
network report 12

setup
scan to email and network

folder 117
shortcuts (Windows)

creating 28
using 26
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size, copy
reducing or enlarging 82

sleep delay
disabling 131
enabling 131

small documents
copying 87

software
HP Utility for Mac 129
problems 180
Readiris OCR 116
scanning from TWAIN or

WIA 116
uninstalling for Mac 185
uninstalling for Windows 184

special paper for covers
printing (Mac) 46
printing (Windows) 44

status
Home screen, control panel 10
HP Utility, Mac 129
supplies, printing report 12

subnet mask 124
supplies

counterfeit 188
low threshold settings 133
non-HP 188
ordering 187, 188
part numbers 188
status, viewing with HP Utility

for Mac 129
using when low 133

supplies status page 12
printing 164

T
TCP/IP

manually configuring IPv4
parameters 124

trapping 56
trays

capacity 18
jams, clearing 156
supported paper sizes 14
supported paper types 15

troubleshooting
checklist 150
jams 155
Mac problems 182
network problems 174

paper feed problems 155
repeating defects 166
slow printing 172
USB connection 173
Windows problems 180
wired network 174
wireless network 176

TWAIN-compliant software,
scanning from 116

U
uninstalling Mac software 185
uninstalling Windows software

184
usage page 12
USB cable, part number 188
USB connection

troubleshooting 173
USB port

locating 7

W
watermarks

printing (Mac) 60
printing (Windows) 60

Web Services
applications 123
enabling 123

Web sites
fraud reports 188
ordering supplies 187

WIA-compliant software, scanning
from 116

Windows
driver settings 22
scanning from TWAIN or WIA

software 116
wireless network

troubleshooting 176
wireless network interference 179
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